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1 Safety Information

Safety Information

Before starting installation, setting up, operation and before
maintenance work is carried out, it is essential to read and follow
the appropriate warning and safety information given in this
manual.

Installation, setting up, operation and maintenance of the mod-
ules or devices must take place as intended, i.e. under the condi-
tions of use laid down in this manual and in the technical data for
the relevant module or device.

Intended use

The products in the Q.series range are intended for use in indus-
trial and experimental test engineering and for monitoring
assembly and production processes. Transducers (sensors) for
the acquisition of physical quantities such as voltage, current,
resistance, temperature, force, displacement, torque, mass,
strain and pressure can be connected. The modules are used
exclusively for these kinds of measurement and control applica-
tions. Any application which goes beyond this scope does not fall
within the intended use of the modules.

To ensure safe operation the modules and devices must only be
operated according to the details given in the manuals and tech-
nical data sheets. In addition, the required legal and safety regu-
lations covering the respective application must be followed.

Checking for damage in transit

On receipt of the goods visually check that the packaging and the
module or device together with the data medium are intact. Also
check the shipment for completeness (accessory parts, documen-
tation, auxiliary aids, etc.). If the packaging has been damaged in
transit or if you suspect that the product is damaged or may mal-
function, the product must not be put into operation. In this case
contact your customer consultant or Gantner Instruments GmbH.

Personnel

The installation, operation and maintenance of the modules or
devices must only be carried out by competent persons. Compe-
tent persons are those who through their professional education
have sufficient knowledge in the required field and are familiar
with the relevant national occupational protection regulations,
accident prevention regulations, guidelines and accepted engi-
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neering rules. They must be able to reliably assess the results of
their work and must be familiar with the contents of this manual.

Electrical connections must only be carried out by specialist per-
sonnel trained for the task.

In particular, pay attention to the following:

« the national installation and erection regulations (e.g. OVE,
VDE, etc.)

* generally accepted engineering rules

¢ the details on transport, installation, operation, servicing,
maintenance and disposal in this manual.

* the parameters, limits and the details about the operating and
ambient conditions on the name-plates and in the data sheets.

Siting locations

The devices in the Q.series range are protected to IP20 against
water, dirt and small parts. If the ambient conditions require it,
the modules can be fitted in water-protected or watertight hous-
ings.

Please note the admissible ambient temperatures specified in the
technical data.

Modifications

Making modifications to the modules or devices is not permitted.
Dirt and shrouding covers may only be removed for service and
maintenance purposes.

Servicing and cleaning

The modules or devices do not need any servicing. Cleaning may
only take place in the voltage-free state. Therefore follow the
points below:

¢ Before cleaning, disconnect all connectors.

¢ Clean the housing with a soft, slightly moistened cloth. Never
use any solvents, because these may attack the labels.

¢  When cleaning, make sure that no liquid enters into the
device or goes onto the terminals.

Never attempt to repair nor to again operate devices which are
defective, have developed a fault or are damaged. In this case it
is essential to contact your customer consultant or Gantner
Instruments GmbH.
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Disposal

Old devices which are no longer usable must be disposed of
according to national and local regulations regarding environ-
mental protection and raw-material recycling. Electronic compo-
nents must not be disposed of with the household refuse. The
packaging can be recycled and should therefore be passed into
the recycling system. However, we recommend that the packag-
ing is kept until the end of the warranty period so that you can
pack faulty devices or modules properly.

General hazards due to non-observance of the
safety information

The modules or devices conform to the state of the art and are
operationally safe. However residual risks may arise when they
are used and operated improperly by untrained personnel.

Any person commissioned with the task of siting, operating, ser-
vicing or repairing a module or device in the Q.series must have
read and understood the operating manual and in particular the
information relating to safety.
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2 Labels and warning information

Labels and warning infor-
mation

Warning information

To prevent damage to property it is essential that you follow the
warning information given in this operating manual.

NOTICE

Indicates a situation in which the consequence may be property
damage if the information is not followed.

Labels on the modules

Symbol: c €

Meaning: This symbol is the CE marking. This shows that we
guarantee that our product meets the requirements of the rele-
vant EC directives.

Labels in this manual

To simplify reading this manual we use the following labels and
notation:

n IMPORTANT
Paragraphs with this symbol give important information about
the product or about using the product.

B ip
Contains application hints and other particularly useful informa-
tion.

italics signifies highlighted text

interface signifies entries and entry fields in program
user interfaces

Options indicates menu items in the program user
interfaces
> signifies a sequence of menu items, e.g. in

Options > Settings

- indicates special features or restrictions
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3 Introduction

Austria

Germany

Introduction

Dear Customer,

Thank you for purchasing a product in the Q.series from Gantner
Instruments GmbH. We are sure that you have obtained an excel-
lent product which will enable you to make fast and reliable mea-
surements with low measurement uncertainties.

If you find faults on the product or errors in the accompanying
documentation or if you have suggestions for improvement,
please contact your customer consultant or Gantner Instruments
GmbH directly. We would be glad to receive your comments and
ideas.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all
sections are open to the public).

Gantner Instruments GmbH
Montafonerstr. 4
6780 Schruns/Austria

Tel.: +43 (0) 5556 77463-0
Fax: +43 (0) 5556 77463-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Gantner Instruments Test & Measurement GmbH
Heidelberger Landstr. 74
64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
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The documentation of the Q.brixx station

The documentation for the Q.brixx station consists of this man-

ual. A further manual is obtainable for the modules to be con-

nected to the Q.brixx station.

You will find this manual also as a PDF file on our home page

www.gantner-instruments.com and on the Gantner CD enclosed

with your Q.brixx station or which you can order free of charge
from Gantner Instruments GmbH.

About this manual

This manual describes the installation, operation and configura-

tion of the Q.brixx station using the test.commander program.

The programming of the Q.brixx station with the test.con pro-

gram is described in a separate manual.

The manual is divided into several chapters:

¢ Safety information in Chapter 1, page 7ff.

¢ A description of the labels and symbols used on the Q.brixx
station and in this documentation can be found in Chapter 2,
page 11ff.

* An overview, showing a complete system (including modules)
and which variants are available, can be found in the next sec-
tion.

¢ The description of the terminal assignments on the inputs and
outputs can be found in Chapter 4, Connectors and indica-
tors, page 17ff.

e Chapter 5, Q.brixx station connection describes how you
establish the connection to a PC, how you synchronize several
Test Controllers and how you carry out a firmware update
when required (page 23ff.).

¢ The basic configuration of your system, which settings you
have to make via the test.commander program so that you can
carry out measurements, is explained in Chapter 6, Basic con-
figuration of your system, page 37ff.).

* The settings for recording data using one of the integrated
data loggers as well as examples of logger configuration are
included in Chapter 7, Recording with the data logger,
page 69ff.

e Chapter 8, Access to data in the Q.brixx station describes the
different possibilities how to access and transfer data stored
in the Q.brixx station and how to control it remotely
(page 97ff.).

Vers. No. 1.5
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3 Introduction

System description

The modules in the Q.series have been developed for industrial
and experimental measurement and test engineering, in particu-
lar for multi-channel measurements of electrical, mechanical and
thermal signals on engine and component test-rigs as well as for
monitoring processes and long-term supervision.

Q.bloxx modules can be combined with the Q.brixx station to
form one system as required. You can connect up 16 modules to a
Test Controller Q.brixx station and then address them from a PC
or PLC via a single interface. The Q.brixx station can only be
operated together with Q.brixx modules.

The Q.brixx station is obtainable in four variants:

PAC, graphically pro-
VGA display grammable with

test.con, HMI Designer

Q.brixx station connectable -

Q.brixx station T | connectable X

In this documentation the connection and configuration for both
variants is described; only the description of the PAC functional
features and working with test.con are not included in this man-
ual.

Application of the Q.brixx station

The Q.brixx station Test Controller is a programmable module
with 1 Gbyte of RAM and an internal hard disk of which 1 Gbyte
is available for data storage using logger functions. The Test Con-
troller can be configured and programmed over wide ranges and
in some versions it also has a graphical display. Optionally, you
have EtherCAT slave, standard Ethernet with 1 Gbyte/s, USB
interfaces, CAN bus and a web server available.

The Q.brixx station is twice as wide as the Q.brixx modules and
must always be mounted to the left in the Q.brixx system. In one
system you can operate up to 16 modules on the Q.brixx station.
Here, 8 channels can be acquired at up to 100 kHz sample rate
per channel. From firmware V1.1 onwards a 48 MBaud transfer
rate and a resultant doubling of the speed are possible. A possible
configuration with eight modules is shown in Fig. 3-1.

Q.series
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Q.brixx system with Q.brixx station.

UART data throughput at 24 MBaud
Sample rate 10kHz
Sample rate 100kHz

128 channels
16 channels

Ethernet data throughput (transmission rate with
block transfer)

512 real variables (10kHz)
32 real variables (100kHz and 48 MBaud)

EtherCAT data throughput (transmission rate)

Read 253 values and write 253 values at 10
kHz, cycle time =100ps

Interfaces

Ethernet, EtherCAT, 1x CAN bus, SD card,
2x USB 2.0 with up to 4 Mbyte/s, eSATA

Max. number of slaves

16

16
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4  Connectors and indicators — Connector assignment for the Q.brixx station

Connectors and indicators

This chapter contains the description of the connectors (pin
assignments) and the LED indicators.

Connector assignment for the Q.brixx station

The Q.brixx station offers you eight digital inputs and four digital
outputs, one CAN bus interface, two USB 2.0 interfaces and an
eSATA interface for external storage media. The digital inputs
are brought out via an 8-pole plug and the supply voltage via a 2-
pole plug (Fig. 4-1).

UART 3B (top, red marking)
UART 3A (bottom)

Ethernot

UART 4B (top, red marking)

USB1 (left) | UART 4A (bottom)

L
g
o
8
| 2
]
}

USB2 (right) —

2 xUSB

CAN1 Low (top, red marking)
CAN1 High (bottom)

eSATA interface ~ .
- CAN2 not yet available

USB/SATA

Digital inputs | DVI interface for monitors with

digital input
Power supply + _|

(upper pin, red marking) Synchronization, the sockets

are connected internally to

obtain two connections

SyB (top, red marking)

X , &) . SyA (bottom)

Power supply - _A
(lower pin)

L 3

Fig. 4-1 Terminal arrangement on the Q.brixx station.

n IMPORTANT
When accessing the Q.brixx station by FTP, USB1 is displayed as
USBO and USB2 as USB1.

We recommend that only screened CAN bus cable is used.

Supply voltage An unregulated direct voltage between 10 and 30 volts is needed
for the power supply. The Q.brixx station itself needs approx. 12
W of supplied power; the power required for supplying the mod-

Q.series
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Digital inputs

ules is not included. The power required is almost constant over
the complete voltage range.

Pin Digital input plug assignment

1 (red marking) +5 V auxiliary voltage for digital inputs
2 DI1
DI2
D13
D14

3

4

5

6 DI5
7 DI6
8

Digital input 0V, GND

Fig. 4-2  Terminal assignment of the socket for the digital inputs of
the Q.brixx station Test Controller.

You can freely assign the digital inputs using the test.commander
(Section 6.3, page 51). The DI1 input must be used if you want to
set up synchronization through IRIG-B and digital inputs. You can
select the input level in the test.commander between TTL
(switching level <1 V and >3.5 V) and PLC (switching level <7 V
and > 8 V) (Settings > General remarks > Digital input
switching threshold; refer to Section 6.1.1, page 39).

Interfaces

Ethernet connection

The Ethernet sockets use the standard pin assignment and you
can directly insert standard Ethernet cable (R]J45). Cross cables
are not needed and, if required, the switchover takes place auto-
matically in the Q.station 101.

We recommend the use of cables to category Cat-5 or better.

USB connection

The pin assignment of the USB sockets is as usual, so you can
directly insert appropriate USB memory sticks. The memory
sticks must be formatted in the ext3 or FAT32 format; other for-
mats, e.g. NTFS, are not allowed.

18
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4  Connectors and indicators — LED flashing frequency

NOTICE

The interface can be loaded with up to 100 mA. Use a separate
power supply for devices with a higher current requirement (also
start-up current), e.g. external hard disks.

The maximum transfer rate is approx. 4 Mbyte/s where this is
supported by the connected memory device.

eSATA interface

You can connect all commercially available SATA hard disks or
memories with SATA interface which are formatted in the ext3 or
FAT32 format. Other formats, e.g. NTFS, are not allowed.

DVI interface (external monitor)

You can connect any commercially available monitor with a digi-
tal interface which can display a resolution of 1024 x 768. Moni-
tors which use analog signals via the digital interface are not sup-
ported.

LED flashing frequency

Flashing frequencies of the Q.brixx station

No error, everything OK

The blue LED (RUN) lights permanently, the orange LED (ERR) is
off.

Storage to external memory running

The blue LED flashes quickly. You can remove the storage
medium, e.g. a USB stick, when the flashing stops.

Error
The blue LED lights permanently and the orange LED flashes
(one flash with a pause in each case).

Read out the error status via the test.commander; refer to
Section 6.5.4, Reading status information on page 66.

Firmware error

The orange LED lights permanently: The firmware could not be
loaded.

The blue LED is off permanently: The FPGA cannot start the firm-
ware.

Try a restart. If this does not help, please contact our Support. In
most cases the system can be reset by a service script which is

Q.series
Gantner Instruments GmbH
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blue LED 1
redLED1 m n
redLED2 & &

located in the subfolder Additional of the installation directory.
Copy the script to a USB memory stick which you insert before
switching the Q.brixx station on.

Both the orange and the blue LEDs may light continuously. If this
occurs for longer than about two minutes, the firmware update
could fail. Try to carry out the update again or contact our Sup-
port.

Module flashing frequency

The modules have three LEDs: one blue LED on the upper edge
and one red LED per connector strip. In normal operation the
blue LED lights, but the red LEDs do not light. Depending on the
error, the LED of the affected connector strip or the blue LED
lights or all LEDs flash in a certain order. In the following illustra-
tions a short dash corresponds to short flash and a long dash to a
long flash.

SOS, configuration error

Fig. 4-3  Flashing sequence with an incorrect module or when

there are no settings in the base.

3

Cause: The configuration saved in the base does not match that in
the module.

There may be two reasons for this:
1. There is no configuration in the base yet.

2. The module type saved in the base configuration differs from
the plugged-in module, therefore the configuration cannot be
accepted.

Consequently, either change the module for the correct module

type or reconfigure the module (Chapter 6, Basic configuration of

your system, page 37). The (new) configuration is then automati-
cally saved in the base.

Firmware download

I = & = n n m nm g blueLED
E & B B B B ® ®§ mredlEDI1

E B B B B B E ®E N redLED2
Fig.4-4  Flashing sequence on downloading the module firmware.

The LEDs flash while the firmware download into the module is
taking place.

20
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4  Connectors and indicators — LED flashing frequency

Activating the firmware download

] ] ] ] ] m redlLED1
E ®E ©®§ ©®E ©®E ©§redLED2

Fig. 4-5  Flashing sequence on activating the firmware.

The LEDs flash while the firmware is being configured after a
download. After the download the module must be restarted.

Problems during data transmission

iR EN ER ENR ER
or

Fig.4-6  Flashing sequence for problems during the data transmis-
sion.

These flashing sequences indicate a problem with the communi-
cation. Check the following:

1. Isthe interface link between the modules in order (are the
bases plugged together or connected to the cables correctly)?

2. Is the interface link between the modules and the Test Con-
troller in order?

3. Is wiring of the interface connections correct?

Then restart the system (by switching off, waiting one minute and
then switching on again). If these measures do not remedy the
error, then contact your customer consultant or Gantner
Instruments GmbH directly.

LED displays in normal operation

For modules with analog inputs a red illuminated LED indicates
that the measurement range has been exceeded on at least one
input. You can suppress this indication in the module configura-
tion.

For modules with digital inputs or outputs an orange illuminated
LED indicates that an input or output is active.

Q.series
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5 Q.brixx station connection — Connect Q.brixx station to Ethernet network with server

Q.brixx station connection

This chapter contains the description of how you connect the
Q.brixx station to a PC.

Refer to the manual Q.bloxx for the connection of sensors and
inputs/outputs to the Q.bloxx modules.

If you have connected a monitor to the Q.brixx station, you can
enter the IP address via the display. To do this, connect a com-
mercially available mouse to the USB port before you switch the
Q.brixx station on (otherwise a restart is needed). Otherwise you
must first establish communication once only with the Q.brixx
station via the test.commander program. This can take place via
a fixed IP address or the automatic address allocation (DHCP). If
necessary, you can then allocate a fixed address for further oper-
ation to the Q.brixx station Test Controller; refer to

Section 6.1.3.2, page 44.

= With a known address you can also establish a connection via the
VNC Viewer; refer to Section 8.2, Remote control by VNC,
page 101.

Connect Q.brixx station to Ethernet network
with server

In the factory setting the Test Controller Q.brixx station uses
DHCP (Dynamic Host Configuration Protocol), i.e. it receives a
valid network address from a server which is present in the net-
work. If you connect the PC to an Ethernet switch, an IP address
is automatically allocated and you can establish the connection
via test.commander.

i
We recommend the use of industrial Ethernet switches. The

Q.brixx station uses autonegotiation and operates, if available,
with 1000Mbit/s and full duplex for the transmission.

Connect Q.brixx station to an Ethernet interface

If you are not connected to a network or if no server is located in
the network, you have the following options:

1. You use a fixed address from the range 192.168.1.x for your
PC. In principle with a network you can also establish a con-
nection when the network uses a different address range. But
it is better in these cases to establish a direct link initially and

Q.series
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Procedure

then to allocate an address to the Q.brixx station from the
address range of your network.

If the Test Controller does not receive an IP address from a
server, then it adjusts to its static IP address after a few sec-
onds. The factory setting of the static IP address is
192.168.1.28. Therefore, set your PC, for example, to
192.168.1.10.

2. You are using an external monitor and have connected a com-
mercially available mouse via USB before switching on.

Click on the tile Network and in the following screen enter an
IP address from the address range of your PC as the address
for the Q.brixx station.

The IP address used (and whether DHCP is used or not) is shown
in the display of an external monitor if one is used.

Network

DHCP: ﬁ
192.168.100.15

Fig. 5-1 Displaying the IP address.

B Tip
Refer also to Section 5.6, Ethernet on the PC, on page 31 for the
display and setting of the PC IP address.

Establishing a connection

A project is created by the test.commander in the course of estab-
lishing a connection. A project contains the hardware setup, the
sensor and I/O settings present in the modules as well as the sen-
sor signals used and computations, the so-called variables, which
are to be output. You load this project later to be able to carry out
settings.

1. Make sure that the current version of the test.commander
software is installed on your PC.
You will find the current version in the download section of
our home page. If necessary, install the current version; refer
to Section 5.5 on page 30.

2. Start the software and select Open initial operation assis-
tant.

Another program window opens.
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3. Enter a name for the project.

Select the network adapter to which the Test Controller is
connected.

5. Specify which network type you are using.

a) A DHCP server is available in the network used. For a
new Test Controller activate DHCP is activated.

b) The controller will be connected to a network without
DHCEP server or The controller will be directly connected
to the PC.

6. Make sure that the Ethernet interface of the Test Controller is
connected and the power supply is only switched on after con-
nection to the network or PC. Then click on Continue.

If this is the first connection which you are establishing, you must
obtain access to the network for the test.commander (requires
administrator rights).

7. Wait until your Q.brixx station Test Controller is displayed.
Mark the entry and click on Continue.

If the Test Controller is not shown, check the IP address in the
display (if available). Otherwise check whether the server has
allocated an address to the module. Also check whether the

network cable is correctly inserted and, if necessary, whether
the port on the switch is active. Then carry out a scan again.

8. Ifyou are not using a network with DHCP server, you obtain a
dialog with the possibility of allocating a fixed IP address to
the controller. Then enter an IP address from the range of
your network or PC.

9. Read the configuration out again, check the variables (names)
and, if necessary, make corrections and open the assistant
with a click on Continue.

Finally, a window is shown in which the Test Controller and all
modules with the values of the measuring channels can be seen
(provided they are configured and capable of measurement in the
standard configuration).

Once you have seen the procedure, you can also carry out all the
settings yourself for further projects, i.e. create a new (blank)
project and then add your Controller Online, etc.

Synchronization of several systems

The synchronization of the Q.brixx modules is ensured by the
Test Controller Q.brixx station. You can also interconnect the
Q.brixx station with other types of test controller, e.g. with Q.pac.
With Q.gate the connection is possible optionally.

All synchronized modules operate synchronously and the maxi-
mum jitter is approx. =0.5pus over all modules. The synchroniza-
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tion line transfers not just a clock signal, but also the date and
time.

You have various methods of obtaining synchronization, even
with several systems, i.e. several Test Controllers; (refer also to
Fig. 5-2 on page 27):

1.

Use the time signal in the Q.brixx station Test Controllers
based on the IRIG standard (Inter Range Instrumentation
Group) to synchronize all other Test Controllers to one master
controller.

The master controller (the device which is not configured as a
slave, refer to Section 6.1.1.3, Synchronization, page 40) uses
its internal clock for the date/time stamp (gray path in Fig. 5-
2). For this type of synchronization (inputs SyA and SyB) you
must lay synchronization lines between the Test Controllers;
the maximum length of all lines together is 400m. The master
controller transfers the time stamp through an RS-485 link to
the other Test Controllers. This method achieves the best
time synchronization with the smallest jitter (approx. £2us)
between the individual modules, because the time informa-
tion passes simultaneously to all Test Controllers.

. You connect a radio receiver for time signals, e.g. for DCF77

which converts the received time signal to IRIG-B or AFNOR
NF S87-500, to a Test Controller.

As master controller this then synchronizes all other Test
Controllers using IRIG (orange colored path in Fig. 5-2) as
with Variant 1. If it is not possible to connect the individual
Test Controllers via synchronization lines or this is not
desired, you can also connect a receiver to each Test Con-
troller (Variant 2b).

You connect an NMEA-0183 compatible GPS receiver (Global
Positioning System) to a Test Controller, which then, similar

to Variant 1, synchronizes as master controller all other Test
Controllers (from firmware V1.08).

With this method the time information of the GPS signal is
evaluated instead of a pure time signal. In addition you can
also process the position details of the GPS receiver in the
system and assign the measurements (light blue path in
Fig. 5-2). If it is not possible to connect the individual Test
Controllers via synchronization lines or this is not desired,
you can also connect a receiver to each Test Controller (also
to a Q.gate Test Controller) (Variant 3b).

You define a PC as an SNTP time server which can distribute
the NTP time stamp to all Q.brixx station, Q.gate or Q.pac
Test Controllers (dark blue path in Fig. 5-2).

. You use EtherCAT for the synchronization of the Test Con-

troller (distributed clock).

26

Vers. No. 1.5
Released: 15/10/2018



5 Q.brixx station connection — Synchronization of several systems

DCF77/GPS

GPS

NMEA over USB

BN iMPORTANT
The maximum length of the synchronization cables on SyA and
SyB is 400m.

Controller 2

IRIG over RS5485

EtherCAT

o

Master Controller

Controller 3

25

Controller 4

Fig. 5-2  Possible types of time synchronization.

The absolute accuracy of the time information depends on the
method used. If you do not want to use or cannot use any time
synchronization lines, e.g. because the spacing of the systems is
too large, you must expect greater deviations. In the variant 2b
the deviations lie in the range from a few milliseconds up to about
100 milliseconds, but this depends on various factors, e.g. how
often the time information is received. In the variant 3b the time
accuracy of the GPS signal is decisive, which is only approx. 1
second absolute.

The fourth method uses, for example, the SNTP protocol (Simple
Network Time Protocol) used in the Microsoft Windows operating
system to transfer the date and time via Ethernet. However, the

individual Test Controllers must always query the time server in
order to be able to synchronize their times to the time server. The
achievable accuracy is therefore not as good as for the first three
methods. If required, you can also set up a (full) NTP time server
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on a PC and synchronize it with a time server in the Internet. You
will find further information about this at http://www.mein-
berg.de (here you can also downloaded a time server program)
and at http://www.pool.ntp.org. The time accuracy is then only
dependent on the change in the response times in your network.

The fifth method receives the time signal from a EtherCAT mas-
ter. Here, the time delay of the signal is fed back to the master
(from firmware version 1.7.2) which then calculates a new time
signal. The time resolution of the signal is 1 us. The start date of
this time calculation is 1.1.2000.

If you combine several synchronization methods, the best possi-
ble one is always used from those available:

1. Hardware synchronization (synchronization of the Q.series,
EtherCAT, IRIG-B or AFNOR using a time signal, e.g. DCF77)

2. Time signal from GPS (NMEA-0183)
3. SNTP

The configuration of the synchronization in all cases occurs via
the test.commander program. Apart from synchronization via
SNTP (Section 6.1.3.5, page 47) you set the type of synchroniza-
tion used via the menu Settings > Synchronization; refer to
Section 6.1.1.3, page 40.

Connection of aradio receiver for time signals
The Q.brixx station can process the following time signals:
* AFNOR NF S87-500

« IRIG B003

« IRIG B005

Depending on the output signal of your receiver you basically
have the following methods:

1. Thereceiver, e.g. for DCF77, is connected to the digital IOs of
the Q.brixx station Test Controller (plug-in terminal Digital
Input, connections DI1 and GND; refer to Section 4.1,
page 17f). The variant is suitable if the receiver outputs sig-
nals at a TTL level. This is the case, for example, with Hopf
clocks (IRIG-B003 or IRIG-B005 depending on type) with TTL
output (e.g. module 4465 with interface version 5).

2. The receiver is connected through the sync input (connec-
tions SyA and SyB; refer to Section 4.1, page 17). The variant
is only possible when the receiver has an RS-485 interface,
because the sync input uses this interface.

With Settings > Synchronization, specify which variant you
are using; refer to Section 6.1.1.3, page 40.
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Evaluation of position data

Connection of a GPS receiver

NMEA-compatible or Garmin GPS receivers can be connected to
the Q.brixx station Test Controller via the USB interface. If your
device only has one RS-232 interface, you can use a commercially
available RS-232-to-USB adapter.

Here, define the interface settings (for the connection refer also
to Fig. 4-1 on page 17). If no new time information is received
within the time period specified for the communication monitor-
ing, the Q.brixx station uses the next available synchronization
method.

4% Q.station 101 DT 192.168.100.115 (@192.168.100.18) Darmstadt [E=E=

Tame Yalue

+ Eg Settings -
+ Eg Slave interface

+ E}g Host interface

= @ USE devices

[¥ Count; 1
= @ Device #1
¥ Part: 1SB 1 [
= [¥ Protocol Gamin USB-GPS
[¥ Timezone offset: [sec): 3600
[& Address: 0
[¥ Baudrate: 9kE
[¥ Char Format; el
L& ‘watchdog Timeout [5] 5
[ Answer Delay [z] i =

\V‘f oK ‘ 2( Cancel ‘

Fig. 5-3  Settings for a GPS receiver from Garmin

Use the variable GetPositioningData to evaluate the individual
data items of your GPS receiver; refer to Fig. 5-4. You need one
dedicated variable for each item of data supplied by your
receiver. The various messages which contain the relevant value,
e.g. GGA, are listed in the explanation of the command. You have
to re-enter the port here, because several receivers may be con-
nected.
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( e edit formula from virtual channel | S |
V5:=|GetPositioningData(100:1)] -
v1-10
Rl Timestamp wWh Force left
W Digital Input W TensileForce left
W3 Start_Bed. W Force right
W Arnithmetic_Empty W9 TensileForce right
Wh Arithmetic_Empty_1
System Variables
| CycleCounter ﬂ Set |
Functions and Operators
FTRSendvirtualBufferFile -
GetFreetemoryOfDataDrivelnPercant ! ( )
GetPositioningData
GetSystemHealth * |AMD| OR
High
Higher - |®oR| %
HigherEgual =
choose Function v | EAL A
1 Latitude GarminGPS, GGL.GGA RMC -
2 Longitude GarminGPS, GGL.GGARMC
3 Speed meter/second GarminGPS, RkC
4 Heading 0 = narth, 90 = east, 180 = zouth, 270 = west GarminGPS, RMC
o] Sa.t Count nulmbers of zeen satelites GarminGF’S, GSY.GGA il
“FJ oK | 2‘( Cancel ‘
Fig. 54 Output of the latitude (Parameter = 1) in a variable of the
type ARITHMETIC EMPTY; the GPS receiveris connected
to USB1 (Parameter = 100; refer also to Fig. 5-3).
Installing the test.commander
= We recommend that you close all open programs before the
installation. Administrator rights are needed for the installation.
Insert the Gantner CD into your CD drive. In the standard config-
uration Windows opens the CD automatically and a start window
appears. If you have deactivated the Windows autostart function,
find the file StartUp.exe in the main directory on the CD and give
the corresponding symbol a double click to obtain the start win-
dow. Alternatively, you can also start the program Setup.exe in
the folder test.commander to carry out the installation directly.
= The program ICP 100 is installed together with the program
test.commander.
You will also find the relevant latest versions of the programs on
our home page www.gantner-instruments.com via Software >
Download.
Vers. No. 1.5
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Procedure

¢ Click on the symbol over Load software.

e Click on the symbol g next to the program which you
want to install.
The program Setup.exe is started.

e Allow the file to open so that the installation can start.
The starting dialog of the setup program appears.

¢ Follow the instructions of the setup program to define the
installation directory and the program group for the software.
Setup.exe creates the directory you have specified, if neces-
sary and then copies all files to it.

When the program test.commander is started for the first time,
you specify the language for the program user interface (you can
change your selection at any time via Extras > Settings > Lan-
guage).

For the program a license number is needed which you have to
enter to be able to save configurations. You will find the license
numbers in the PDF file enclosed with the supplied items and on
the separate printout with your license data.

Then enter your license data via Help > Info and Licensing. If
you have licensed the program test.commander, then the pro-
gram ICP 100 is also enabled and a further license is not
required.

Ethernet on the PC

The following sections describe various settings which you can
carry out on the PC to enable a link to be formed. The images use
menus and dialogs found in Windows 7; the names of the dialogs
and fields in other versions of Windows are however similar and
are usually also given.

Finding the IP address and subnet mask of the PC
In Windows 7 or 8 open the Network and Sharing Center, e.g.

using [E at the bottom on the right in the taskbar. Click on the
LAN connection (the name may be different) through which the
Test Controller is connected to the PC (Fig. 5-5). In the following
status dialog (similarly in Fig. 5-5) click on Details.

The current address is displayed in the next dialog under IPv4
address.

The subnet mask determines which addresses can be reached
from the PC: Only addresses whose figures are identical in the
places which contain a 255 in the subnet mask can be reached.
The IP addresses of the PC and Test Controller should normally
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be located in the same Ethernet segment (only the last group of
figures in the IP address is different), otherwise the subnet mask
must be 255.255.0.0 so that the last two groups of figures may be

different.

Wiew your basic network information and set up connections

P.L-
[

YIMPCL2WINT
(This computer)

View your active networks

o

Change your networking settings

tid.local
Domain network

'ﬁ;. Set up a new connecticn or nety
= . .
Set up a wireless, broadband, di

Cy Connectto a network

Connect or reconnect to a wirel

Choose homegroup and sharing

Access files and printers located

@ Troubleshoot problems
Diagnose and repair network pr

See full map

o

tid.local

o

Internet
Connect or disconnect

Internet

Connections: I LAN Connection

Access type:

-

| LAM Connection Status ﬁ

1]
™

Fig. 5-5

Example 1

General

Connection
IPw4 Connectivity: Internet
IPwE Connechivity: Mo Internet access
Media State: Enabled
Duration: 00:23:36
Speed: 1.0 Gbps
-

Ackivity

Sent L\F Received
@

Brtes: 790,779 6,939,448

’ '&'Pmperties l ’ 'ﬁ'Disable ] [ Diagnose ]

Viewing/changing the IP address of the PC.

Subnet mask 255.255.255.0, IP address 192.168.100.26

Only addresses can be reached which start with 192.168.100, i.e.
the first three groups of figures must be identical and only the
fourth may be different.

Example 2

Subnet mask 255.255.0.0, IP address 192.168.100.26

All addresses can be reached which start with 192.168, i.e. the
third group of figures may also be different between the PC and

Test Controller.
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Setting the IP address on the PC

If you want to connect to a Test Controller, you must assign a
(temporary) IP address to the PC.

We recommend that a temporary IP address is set up on the PC,
because then the network settings on your PC for the normal con-
nections are not changed. If you have already set up this type of
"alternative configuration" for another network, you must note
the existing settings so that you can restore them after conclud-
ing the configuration of modules or the Test Controller.

In Windows 7 or 8 open the Network and Sharing Center, e.g.

using [E at the bottom on the right in the taskbar. Click on the
LAN connection (the name may be different) through which the
Test Controller is connected to the PC (refer to Fig. 5-5 on

page 32). In the following status dialog click on Properties
(requires administrator rights). Then mark Internet Protocol
Version 4 and click on Properties (refer also to Fig. 5-6).

Then proceed to the register card Alternative Configuration
and specify an address for the PC, e.g. 192.168.100.5, and a
subnet mask, e.g. 255.255.255.0 (Fig. 5-7).

U LAN Connection Properties @
MHetwiarking

Connect using:

L¥ IntellR)] PRO/1000 MT Metwork Cornection

Thiz connection uzes the following ibems;

% Cliert for Microsoft Networks

EQDS Packet Scheduler

E’, File and Printer Sharing for Microsoft Metwark s

i |nternet Protocol Yerzion B [TCPAPYE]

b |nternet Protocol Wersion 4 [TCPAPwd]

i Link-Layer Topology Dizcovery Mapper [0 Driver
<& Link-Layer Topology Dizcovery Responder

Imstall... Unirztal Properties h

Description

Tranzmizzion Control Protocol/lnternet Pratocal. The default
wide area network, protocal that provides communication
across diverse interconnected networks.

[ Ok H Cancel I

Fig. 5-6  LAN connection properties (Windows 7 and 8).
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Internet Protecol Version 4 (TCP/IPv4) Properties -7 =]
General | Alternate Configuration | h
If this computer is used on more than one network, enter the alternate IP
settings below.
() Automatic private IP address
* i@ User configured
IP address: 192 . 168 . 100 .
Subnet mask: 255,255,255, O
Default gateway:
Preferred DMS server:
Alternate DNS server:
Preferred WINS server:
Alternate WINS server:
[ oK l [ Cancel ]
Fig. 5-7  Defining the IP address and subnet mask for an alterna-
tive (temporary) configuration.
Allowing access to network devices (firewall)
Generally, a firewall monitoring access of the PC to the network
and vice versa is installed on the PC. Therefore, you must allow
access to the Test Controller or the module, otherwise no connec-
tion can be established via Ethernet. On the first attempt to
establish a connection you receive a message similar to that
shown in Fig. 5-8. Click on Unblock to allow the connection.
) IMPORTANT
You must possess administrator rights on the PC to be able to
unblock the connection. If this is not the case, ask your adminis-
trator to do this for you. You must enable all programs for sharing
which use an Ethernet connection to the modules or the Test
Controllers.
Vers. No. 1.5
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@ Windows Firewall has blocked some features of this program

wWindows Firewall has blocked some Features of Setupfssistant.exe on all public, private and
dornain networks,

G Mame: Setuphssistant.exe
ﬂ""‘"" Publishier: Gankner Instruments
Path: C:h\program files\gantner instrumentsitest, commander

\tools\setupassistant, exe
Allovs SetupAssistant.exe to communicate on these networks:

Domain netwaorks, such as a workplace network
[] Private networks, such as my home or work network

[] Public netwarks, such as thase in airports and coffee shops (nak recammended
because these networks often have little or no security)

what are the risks of allowing a program through a Firewall?

@ Windows Security Alert ﬁ

[ '@'Allnw access ] [ Cancel ]

Fig. 5-8  Firewall message from Windows 7 when attempting to

connect through Ethernet; here for the Setup Assistant.
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6 Basic configuration of your system

Basic configuration of your
system

You must first create a project and establish contact with the
module before you can configure it. You will find a description of
the working steps in Chapter 5, Q.brixx station connection,

page 23.

The following chapter describes the most important settings to
be able to measure with the Q.brixx station.

n IMPORTANT

If you would like to combine modules or Test Controllers from
older applications and recently purchased ones, all components
should use the latest relevant internal software, the so-called
firmware. To ensure this, carry out a firmware update; refer to
Section 6.6, page 67.

Basic procedure

¢ Establish the connection (communication) between the PC
and Test Controller; refer to Chapter 5, Q.brixx station con-
nection, page 23.

e Start the configuration program.

» First, start with the basic configuration of the Test Controller
and leave the definition of further settings, such as system
variables or storage settings, to the end.

¢ Enter the sensors used and their sensitivities to obtain an
indication in the measured physical quantity. Define computa-
tions, digital inputs/outputs, alarm monitoring, etc. These
working steps are described in the manual for the Q.series
modules.

¢ Specify which data are to be recorded and how; refer to
Chapter 7, Recording with the data logger, page 69.

¢ Activate all settings in the modules and in the Test Controller.

n IMPORTANT
After changes to the configuration of modules or a Test Con-

troller ¥ is displayed in the project tree. Select E‘:_j? or File >
Write project (update) in the test.commander to update the
settings in the project (and in the Test Controller). The project
file is automatically saved.

Q.series
Gantner Instruments GmbH

37



6 Basic configuration of your system — Q.brixx station basic settings

Gantner

instruments

i Project: Dabdeas12

= [ |
- Spstem variables
+- W Digital 170
£ W Witual vanables
- 0 Q.blows A107 [242) TestStand2
#- N G.blows &107 [2/3) TestStand3

Li

At many points in the software you can call the setting dialogs or
settings via the context menu of an entry. You call the context
menu with the right mouse key.

You process a complete variable in the configuration dialog in
that you click on the variable in the left column (contains the vari-
able number Vx) to mark it. Using the context menu, you can then
cut, paste and copy the variable, overwrite it with a copied vari-
able or delete it.

Q.brixx station basic settings

In the Test Controller you specify, for example, the type and
scope of the synchronization, set the (synchronous) output rate
and baud rate of the modules to be used or define which bus diag-
nostic data or life signs are to be transmitted. In addition, you can
check all the settings of host and module interfaces, allocate a
location name, etc. The following sections deal with the most
important settings; further settings are explained in separate
chapters.

Mark the Test Controller to be set and select Settings from the
context menu or double click on the Test Controller to start the
configuration program.

42 Q.station 101 DT 192.168.100.115 (@192.168.100.18) Darmstadt [ = [ E [

Mame Yalue
g Ererury

+- [ Life signal
+ [ Synchronisation
= @ Slave interface
+- [55 RS 485 #1
+- [ RS 485 #2
= [ RS 485 #3
+- (5 RS 485 #4
+- [55 CaM #1
= 5] Hostinterface
+ [ Fieldbus
+- (5 ETHERNET
& e
B Metwork drives
B SNTP
5 Datapart
B General il

m

e o [ A O e

wﬁ 114 ‘ ‘K Cancel ‘

Fig. 6-1  Configuration dialog for a Q.brixx station Test Controller
(extract).

Then you can carry out all the module settings in the window of
this dialog. A tree structure similar to that in Windows Explorer
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Location

PAC functionality

Buffer pre-initialization

Filling pattern

Switching threshold of the
digital inputs

System cycle frequency

shows the individual parameter groups. Open up the entries as

required by a click on [#-.

Settings

Using this parameter group you define, for example, life signs or
the location name.

General remarks

Here you allocate a name for the Test Controller, e.g. the loca-
tion. The default setting is Undef.

The PAC functionality offers the possibility of autonomously
implementing (independent of the PC) any functions of many
measurement quantities and I/Os, calculations, logical opera-
tions, time and transfer elements, etc. with the graphical soft-
ware test.con.

Here, you activate or deactivate the general data access to
Q.brixx station variables (read and write) of the test.con applica-
tions from real-time and user space. The default setting is acti-
vated.

In the Fast filling default setting each measurement transferred
with a bit error leads to an error: the measurement is set to -1
(default setting for Filling pattern) and the error counter is set.
This generally causes the test-rig to stop. In the setting Deacti-
vated the previous measurement is also used for the present
measurement. If the next measurement is alright again, measure-
ment continues as normal. The error is however counted, but no
alarm is triggered. In the Slow filling setting the process is the
same for two seconds as in the Deactivated setting, thereafter as
in the Fast filling setting. In this way brief disturbances are
ignored.

Value which is used for a defective measurement (refer to Buffer
pre-initialization).

Here, you select whether the TTL level (5 V) or the PLC level (24
V) is used for the digital inputs. With TTL the switching thresh-
olds are <1V and >3.5V and the PLC levels are <7V and >8V.
Refer also to Section 4.1, page 17.

The system cycle frequency provides the (internal) clock for the
processing of virtual variables and test.con applications in the
Q.brixx station. The cycle frequency can be set slower or equal to
the highest sample rate. The maximum cycle frequency is 10 kHz;
it determines the system load.
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Life sign

Here you specify how the life-sign signal (Live signal) is to be pro-
duced. You can output a static signal which only changes its sta-
tus when an error occurs or you can use a dynamic signal which
changes its status between high and low with a certain fre-
quency. You enter the frequency or the half-cycle time under I/O
status change time in seconds. Choose the conditions for which
an error is to be signaled.

n IMPORTANT

The conditions change (note text) when you switch over from
Static to Dynamic, because logical operations with AND or OR
are carried out depending on the type of signal.

Synchronization

In the menu Input synchronization protocol you set both the
type of synchronization used and also the inputs used for it.

If your device is operated as a slave, i.e. if you connect another
Test Controller which has the time information available to SyA
and SyB or you connect a radio receiver for time signals with an
RS-485 output to these connections, specify Q.sync via RS-485.

B8 MPORTANT
The maximum length of the synchronization cables on SyA and
SyB is 400 m.

Specifying EtherCAT DC Time (distributed clock) is only practi-
cable when an EtherCAT master is present.

In the setting None the Test Controller operates with the internal
time (as master for other connected Test Controllers).

If you want to synchronize via SNTP, you have to specify the time
server using Host interface > SNTP; refer to Section 6.1.3.5,
page 47.

Module interface

Using this parameter group you specify the speed of the data
transmission on the individual interfaces (UARTS). Also, the baud
rate for the CAN bus interface is set here.

UART interfaces (RS-485 #1 to #4)

Select the required baud rate (transmission speed). The default
setting is 24 MBaud.
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Communication monitoring

Response delay

6.1.2.2

42 Q.station 101 DT 192.168.100.115 (@192.168.100.18) Darmstadt (=] B et

Mame Yalue
=8 @ Settings

=8 @ Slave interface
= 5 RS 485 11
[ Protocol Localbus

ot

»

Bl

- [& Char Format: 115k2

\watchdog Ti tls]: 187k5
& watchdog Timeout [5] iy

m

& answer Delay [s]
- (5 RS 405 #2

& [ BS 485 #3

- (5 BS 4854

- (B CAN #1

=8 E Host interface .
i [ USE devices <

J [1].4 | ?{ Cancel |

Fig. 6-2  Baud rate selection.
A change in the baud rate is also carried out automatically on the
modules connected to the interface.

With a value > 0 the module error LED is activated if there is a
lack of communication after this period.

This parameter is only needed when the modules are not directly
connected to this interface, but instead connected to a modem,
for example. Then enter the time here which is to be awaited
additionally due to the slow connection.

CAN bus interface

You can both read and send data over this interface. The maxi-
mum possible speed depends on the overall length of the cable
which is connected to the relevant interface.

Cable length in meters Maximum baud rate

1000 <50 kBaud

100 <500 kBaud

50 <800 kBaud

25 <1MBaud

Bl MPORTANT

A change in the baud rate only affects the Q.brixx station; con-
nected CAN devices must be set to the selected baud rate sepa-
rately.
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Gantner

instruments

Communication monitoring

Response delay

With a value > 0 the module error LED is activated if there is a
lack of communication after this period.

With this parameter you can specify an addition time-out period
which is allowed to pass before communication monitoring sig-
nals an error.

Setting up a further CAN bus interface via USB

If required, you can use a further CAN bus interface by employ-
ing the PCAN-USB adapter from PEAK-System Technik GmbH
(http://www.peak-system.com).

During the configuration of the Test Controller in the section
USB devices specify CAN as the protocol and set the CAN baud
rate to be used (Fig. 6-3). Refer to Section 6.4.2, page 56 for the
definition of the data to be read in or to be output.

fwr. Qustation 101 DT 192.168.100,115 (@192.168.100.28) Darmstadt =N = ==
Marne Yalue
- 5 Seftings
+- [ Slave interface
+ E—g Host interface
= @ USE devices
[¥ Count; 2
= @ Device #1
[ Port: LISE 1
[¥ Protocal CaN
[ CAN Baudrate: 280000 j
+- [ Device t2 20000 B
+ E—g Sample rate 1588880
125000
500000
200000
1000000 &
\\yf? (1] 4 ‘ ‘?( Cancel

Fig. 6-3  Configuring the CAN interface via USB.

Host interface

This parameter group defines the settings for the communication
over the interfaces EtherCAT, Modbus, Ethernet, FTP and Data-
port and it enables you to implement access protection for the
Q.brixx station.

Here you also have the possibility of specifying e-mail settings for
messages from a data logger and of defining network drives
which the Q.brixx station Test Controller can access for data stor-
age. This means that a data logger can also save to a network
drive and not just to a local drive.

Field bus (EtherCAT)

The section contains the settings for the EtherCAT interface.
Deactivate the interface if you do not need it.
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B8 MPORTANT

Using the context menu of the Test Controller and Assign read/
write accesses, define which variables are to be available on the
field bus. Activate the read access (READ rights) in the Field
bus column for the relevant variable (Fig. 6-4).

e Assign READ Access Sources = | B S
select permissions to edit: {510 TR S -
Item Circlebuffer | Pac Kernel Fieldbus  |Highspeed TCPIP | Highspeed UDP | Distributor Port | Dataport | RS485 Host | RS232 Host
= Bl Undsf pi
Vo W1 Timestamp [v [v [v [v [v [v [v [v v =
W W2 Digital Qutpot 1 [v [v [v 2 [ [v [v [v v
W W3 Digital Output 2 [v [v [v [v [v [v [v [v v
W W4 Digital Input [v [v [ [v [v [v [v [vw Jvw o
W/’ oK | 7< Cancel |

Communication monitoring

Frequency divider

Fig. 6-4  Enable read access for the field bus.

With a value > 0 and with a lack of communication after this
period the error status becomes active; refer to Section 4.3.1,
page 19.

This value determines the transfer rate for the EtherCAT inter-
face. The divider is required at high data rates to avoid overload-
ing the interface. The value refers to the sample rate #1 and
reduces, where applicable, the data rate on the EtherCAT inter-
face. With a setting of 4 and a sample rate #1 of 4000 Hz the
transfer rate is 1000 Hz (Fig. 6-5).

42 Q.station 101 DT 192.168.100.1 (@192.168.100.20) ... =E—

Tarme: Yalue
@ Settings

B Slave interface

= @ Host interface

= 5 Fieldbus
[¥ Protocol: Ethercat
[ watchdog Timeout [s]: 10
[& Frequency divider 4
5 ETHERNET

&5 FIP

[ Metwark dives
B sNTP

@ e-mail

@ Dataport

[ General

USH devices
Sample rate

[
Egﬂﬂﬂﬂﬂﬂﬂﬂ

[

W/’ 1].4 | ?( Cancel ‘

Fig. 6-5  Setting for the frequency divider.
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Server settings

Client settings

Ethernet

Use this section to assign a fixed IP address to the Q.brixx station
or to set it to DHCP again if you are using the version Q.station
101 or Q.station 101 T (without display).

The stated static IP address is only effective when no DHCP
server is being used.

The IP address used in the setting Use DHCP server: Yes can be
found under General remarks; refer to Section 6.1.3.8, page 48.

FTP

With the function Server settings > Access names you can
implement access control (password protection).

n IMPORTANT
You can work completely without any (Access name: No) or with
all three passwords.

Note down the passwords and keep them in a safe place. If you
have forgotten a password, note down the serial number of your
Test Controller and contact us: office@gantner-instruments.com

You then receive a release code which resets all three passwords.

Here you define an FTP server with which the Q.brixx station can
connect as client. You can then specify for a logger that the cre-
ated files are sent directly to the FTP server.

u IMPORTANT
You have to set up an FTP server appropriately on a PC. There
are many programs which facilitate this, e.g. FileZilla.
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Use passive mode

Type

Directory

42 Q.station 101 DT 192.168.100.115 (@192.168.100.18) Darmstadt EE—~

Mame

‘@@ o~

Yalue

+ Eg Server settings
= 15 Client settings

= [& Configuration mode: marually
¥ Client connection timeout [z] 120
[ Client watchdog timeout [s] 100
L& Client keep alive repeat time [s] 30
= [& FTP connection count 2

m

= @ Connection #1

O Server addrsss: 1921681007 < ————

& Usemame: JohnDoe
¥ Paszsword: 123456
[¥ Por: 21
[& Use passive mode: Ma
& Type: unkrow
& Directony: ADatal
+ E;-_j Connection #2 -

\\‘rf? 0K ‘i{ Cancel

Fig. 6-6  Details about the FTP server so that the Q.brixx station
can access it as a client.

Check whether the settings for your FTP server at Connecting
timeout, Communication monitoring or Transmission inter-
val have to be changed. Then specify how many (maximum ten)
FTP servers you would like to set up. The FTP servers can also
only differ due to the directories. The directory specified at
Directory is created as a subdirectory to the directory released
in the FTP server.

With a passive FTP the client sends a special command which
causes the server to open a port and to send the port and IP
address to the client. The client uses a port via 1023 and the port
just transmitted by the server. This technique is necessary when
the server itself is not capable of establishing a connection to the
client, when the client is located behind a router or when a fire-
wall screens the client from external access.

Since the FTP server can be set up on any operating system, the
client needs information about the form of the response to an
interrogation of the directory. Unfortunately, this is not standard-
ized and, depending on the operating system, the file information
is transmitted in various formats. Using this, the client can
request the size of a file. Therefore, with the Unknown format
only a check is made of whether a file with the name of the trans-
mitted file exists. A check cannot be made of whether the file has
the right size, i.e. whether all the data has been transmitted.

With this option you can define a subdirectory on the FTP server.
If you would like to save the data from different loggers in differ-

Q.series

Gantner Instruments GmbH

45



Gantner

6 Basic configuration of your system — Q.brixx station basic settings instruments

ent directories, simply create the same FTP server with different
subdirectories, e.g. /Datal and /DataZ2.

H Tip

Within the specified directory you can have the logger create fur-
ther subdirectories by using placeholders. The placeholders pos-
sible are identical with those described in Section 7.3.1 for Log-
ger name; refer to page 75.

u IMPORTANT
A differentiation is made between upper and lower case in the
directory path notation.

Network drives

You can also use a network drive as the target memory for a log-
ger, if you do not want to record on a storage medium on the
Q.brixx station (e.g. on USB). You provide the required details via
this dialog (Fig. 6-7).

Name Here, enter the name which is to be used later in the logger for
this target memory.
User name Here, enter the user name for which the target memory, i.e. the
directory, is released.
Password Password for the user name.
Host name IP address or name (requires a DNS server) of the PC on which
the directory is located.
( 45 Q.station 101 DT 192.168.100.1 (@192.168.100.20) Undef SEIE
Mame ‘alue
+ Eﬂ Settings r
£ Ea Slave interface
= @ Host interface
- [5 Fieldbus
+- (5 ETHERNET N
+ @ FTP 3
= @ Mebwork drives
& Count: 2
=15 Diive #1
[¥ Mame FastDrata
[¥ Usemname John
¥ Password
[¥ Hosthame 192.168.100.1
[¥ Remote-directary DataEngineT est -
\‘.V” 114 ‘ 2( Cancel
Fig. 6-7  Specifying network drives.
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Remote folder

Here, enter the directory path, e.g. /Data/EngineTest. The path
name corresponds to the directory path from the released folder.

Example: You have released the subfolder DataFiles in the folder
Testing on drive D:. The directory path is then /DataFiles,
because (at least in the default setting) this is the name of the
release on the relevant PC (host name). On release you can how-
ever also set a different name as the release name.

SNTP

Here, specify the IP address of the NTP server if you want to set
up synchronization via NTP.
Refer also to Section 5.4, page 25.

E-mail

For a logger to be able to send e-mails you must here define the

possible selections for the fields Address, Subject and Content.

In the dialog (Fig. 6-8) specify:

* To which server the mails are to be sent (Sender server
address),

* whether and if yes, how the authentication is to occur,

* how many e-mail addresses and how much information (sub-
ject, content) you need.

You can specify up to ten different addresses, subject lines and
content texts. You can state, for example, the location or test rig
of the Test Controller in a Signature; the text is then always
appended to the end of the mail.

For the configuration of the e-mail refer to Section 7.3.3.8, Send-
ing an e-mail, page 82.
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( 42 Qustation 101 DT 192.168.100.1 (@192.168.100.45) Undef SET
Hame Yalue
+- [55 Slave interface o
= @ Host interface
+ Eg Fieldbus
#- [ ETHERNET
1 Eg FTP
+- [ Metwork drives
# B SNIP
= @ email
= @ Client settings
[& Send server addess 192.168.100.2 E
#- & use Authertification Yes
[& Client e-mail address TestEgantner-instiuments.com
[¥ Client domain wiany. gantner-ingtruments, com
= [& e-mail addresses count 3
[¥ emai addiess #1 datal@gantner-instiuments. com
[¥ e-mai addiess #2 testiEgantner-ingtiuments.com
¥ e-mai address #3 infol@gantner-ingtiuments.com
+- (& emailsubjscts count 3
#- & e-mail body texts count 3
[ Indexed e-mail body texts count a
[¥ Signature TestStand 1 -
V’? oK | ‘?( Cancel ‘
Fig. 6-8  E-muail settings.
Dataport
This section contains the settings for Modbus if this is being used
via TCP/IP (Modbus/TCP).
General remarks (own IP address)
In the DHCP setting this shows the current IP address.
USB devices (GPS, Modbus, CAN)
In this section you can define special USB devices, e.g. a Garmin
GPS receiver or generally an NMEA-0183-compatible GPS
receiver (refer to Section 5.4, page 25), a Modbus interface or a
PCAN-USB adapter (refer to Section 6.1.2.3, Setting up a further
CAN bus interface via USB, page 42).
Modbus interface
You can also set up a Modbus connection via the USB-to-RS-485
converter ISK 103 from Gantner. The drivers for the converter
are present in the Q.brixx station from firmware version 1.09, but
you can also connect many commercially available converters.
Click on E or use File > Read online status information
from controller to call up the status information of the Test Con-
troller which shows whether the converter has been detected
(Fig. 6-9).
Vers. No. 1.5
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i View file content: #actual.sta_mod =NNCN X
Display state info:
GENERAL STATES:
HEALTH: §YS_Act=78.33% / SYS_Aver=75.75% / RT_Act=99.96% / RT_Aver=99.96%
MEASUREMENT MODE ACTIVE
RUN STATES:
USER TESTCOMN PROGRAM ACTIVE: Heizungsregelung
FTF SERVER ACTIVE
DEVICE STATES:
DATADRIVE  Name: Flash (hdD) Files: 9396 Size: 1033166848 Logg: 84.0
USE DEVICE Mame: Seral Port on USE 1 1D:usb0_uart #
ERROR STATES:
<ERROR:: Obj:QStationSystem Code:-5056 T5:2015-02-25 14:40:40 Crt:1
<ERROR>: Obj:Q Station System Code:-5057 T5:2015-02-26 14:40:40 Cnit:1
Fig. 6-9 Status information with detected USB converter on USB1
(indicated as usb 0).
Then define Modbus as the Protocol and specify the data for
your bus system: Should the Q.brixx station operate as Master or
Slave, which baud rate is to be used, etc. (Fig. 6-10). In the con-
figuration as master you can, for example, receive data from an
Ammonit Meteo-40 data logger or transfer Modbus data by radio
via two Phoenix RAD-2400-IFS radio modules.
fde Qustation 101 DT 192,162,100.115 (0192,168,100.28) Darmstadt == =]
lame Yalue
+- [55 Seftings
+- 5 Slave interface
+ Eg Host interface
= @ USE devices
[ Count 2
= @ Device #1
¥ Port: LsSE 1
[¥ Protocol: Modbus
[¥ Operates as master: Tes
[¥ Baudrate: 19k2
[¥ Char Format: ael
[& ‘watchdog Timeout [s]; L1
[ answer Delay [5] ]
+- 55 Device t12
+ Eg Sample rate
| 3
w‘ﬁ 1] 4 | K Cancel
Fig. 6-10 Defining Modbus as the interface for the USB converter.
Transfer format Specify which parity is to be used: none (n), even (e) or odd (o).

Eight data bits and one stop bit are always used so there are only
the settings 8n1, 8el (standard) and 8o1.
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Communication monitoring

Response delay

;. Project: Dahdeas12

= [ |
+ W System variables
#- W Digital 170
#- P Vitual vanables
+ U O.blows A107 [(242) TestStand3
+ 0 O.blows AT07 [243) TestStand3

With a value > 0 and with a lack of communication after this
period the error status becomes active; refer to Section 4.3.1,
page 19.

With this parameter you can specify an additional time-out period
which is allowed to pass before communication monitoring sig-
nals an error.

The other settings can be carried out via the details for the virtual
variables which are to receive data from this interface or send
data to it; refer to Section 6.4.5, Defining Modbus RTU signals,
page 62.

Sample rate and logger settings

With the Q.brixx station you can set up to four sample rates and
data stores. On the data logger you define which data are saved,
how often and where. The settings are written in a chapter of
their own; refer to Chapter 7, Recording with the data logger,
page 69.

System variable

Below the basic settings for the Q.brixx station there are also two
entries for defining variables.

n IMPORTANT

The variable Timestamp created in the default setting (DC sys-
tem time, i.e. date and time since 1.1.2000) must not be deleted.
You can however rename the variable. The time format has a res-
olution in ps.

In the System Variables section specify further time variables if
you would like to use time formats other than in the default sys-
tem time. Context menu for system variables Add new variable
> ABSDATETIME. After a double click on the variable and a fur-
ther click on Formula you can then select other formats (Fig. 6-
11).
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f edit formula from system channel =S X

Y2:=|TimeOLEZ -

System Yariables
| CycleCounter j Set |

TimeOLE2

DCSystemT ime
psSinceStart ( )
Seconds0fDay

SecondsOfHour

TimelnfoFieldbus

choose Function | -

The cycle counter can be used for special calculations. It is generated by the module itzelf.

w‘{’ OK | 7~ Cancel‘

J\,f, Project: Dakdeas12

Fig. 6-11 Dialog for specifying the time format.

In the System variables section (or in the Virtual variables sec-
tion) you can also define time variables, e.g. if actions are to be
carried out at a certain time of day or hourly: Context menu Add
new variable > ARITHMETIC EMPTY. Then click on For-
mula to select a function.

Specifying digital inputs

In this section you create the variables for your digital inputs.
You can also combine several inputs to form a status field and use

= [ | _ two inputs for an up/down counter or a rotated-angle signal with

: e direction detection. PWM or frequency measurements are also

W Wirtual variables pOSSible.

T Q.blowx 2107 [2/2) TestStand3

T Q.bloxx 2107 [2/3) TestStand3
Digital inputs
In the context menu for Digital I/O select New variable > DIGI-
TAL_INPUT. You can also import existing variable definitions
(New variable > Open folder in Explorer).
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%2 Edit digital [/O <Digital Input> | S
Mame Walue
¥ Mame Digital Input
[ Type Counter Standard
¥ Teminal connector Drigital in 4
L& Unit

#- ¥ Scaling type
= @ [rata format settings

Factor and Offzet

[¥ Format EOOL
[ Fieldlength 1
[ Precizion a
[ Data direction INFUT
= [& Use iles for read-access Tes
[ Ciclebuffer access Yes
[¥ PacKemel access Yes
[ Fieldbus access Mo
[¥ Highspeed TCPIP Port access Tes
[¥ Highspeed UDP Port access Yes
[¥ Distributor port access Yes
[ Dataport access Tes
[¥ Host R5485 interface access Tes
[¥ Host R5232 interface access Yes

\\.'/J OK ‘ ‘7( Cancel

Fig. 6-12 Configuration dialog for a digital input.

Type of input

The setting determines how the input is used and which further

settings you must carry out.
1. Status

With this function it is only necessary to specify the connec-
tion terminal. You can leave all other settings on the default
setting, because here only the high or low level is evaluated.

Frequency

You can choose between a simple frequency measurement
(Frequency, standard) and Frequency, 2-wire. The latter
enables you to detect the direction of rotation through the
sign of the frequency (rotational speed) using two digital
inputs.

The setting cannot be currently configured interactively. If
required, please contact our Support.

Counter

Here, you can choose between a simple counter (Counter,
standard), a forwards/reverse counter with two signals offset
by 90° (Counter, quadrature 2-wire), a forwards/reverse
counter with a static direction signal for forwards/reverse
(Counter, up/down) and a forwards/reverse counter with
two 90° offset signals plus index signal (Counter, quadra-
ture 4-wire), i.e. a reference signal at a zero position.
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The setting cannot be currently configured interactively. If
required, please contact our Support.

4. Pulse duration
Pulse duration, period measures the time between the low-
to-high edges of a signal. Pulse duration, active measures
the time at the high level, Pulse duration, passive measures
the time at the low level. With Pulse duration, PWM duty
cycle the ratio between the time period at high level to the
time period at low level is evaluated.
If required, you can specify a conversion factor between the
pulse duration or the duty cycle of the input signal and the
displayed value using Scaling type. Set the Data format,
e.g. to SINT32 (signed integer, 32 bit), Field length 8 and
Decimal (places) 4 (the decimal point also counts as a place).

5. Status field

With the Status field function you can combine several inputs
to form a field. The inputs are evaluated as binary.

The setting cannot be currently configured interactively. If
required, please contact our Support.

The following block diagrams give you an overview of the possi-
ble circuits.

Measurement of status, time, frequency or PWM
(Pulse-Width Modulation), 1 signal

MIrLruL g
Din

_l__®0V

Up/down counter or measurement of frequency and direction with
static direction signal, 2 signals
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o Project: Dahdeas12

Systenn variables

Digital /0

Wirtual variables

. bloxs 2100 [2/2] TestStand3
. bloxs 2100 [2/3) TestStand3

O

-4 A & 4

Measurement of frequency and direction or up/down counter with
2-channel frequency signal (90° phase delay)

_L—®0V

Measurement of frequency and direction or up/down counter with
4-channel frequency signal

Din
Mo —0Q

Index —0Q
Index

—0
enable

_l__®0V

Virtual variable

With virtual variables you can implement calculations, evaluate
trigger conditions, carry out assessments or define CAN bus or
Modbus signals for input or output. The variables can be output
like measurements or you can link them to other variables, mea-
surements or digital I/Os. Virtual variables are also needed if you
want to output computational results from a logger, e.g. by
EtherCAT or Modbus/TCP. The maximum processing speed is 10
kHz.

n IMPORTANT

After creating new variables select E:T-.'f or File > Write project
(update) in the test.commander to transfer the new definition to
the Test Controller. The project file is in this case automatically
updated.

Defining formulas and events

In the context menu for virtual variables select Add new vari-
able > ARITHMETIC_EMPTY. After a double click on the vari-
able you can either specify a formula for the computation, define
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an event which is to be monitored (trigger) or specify the data
format to be used (Fig. 6-13).

e edit virtual channel <Variable 4> =NACN X
MName Walue

[& Mame W ariable_d

[& Type Auithmetic

[& Formula

[& Unit

= @ Ewent
¥ Host Mo
[ Ornvarable [+ > 0.5) deactivated
= @ [ ata format settings

L& Fomnat FLOAT
[ Fieldiength g
[ Precision 3
L& Data direction INPUT

[& Use rules for read-access Mo

v/? 0K ‘ .?( Cancel

Fig. 6-13 Configuration dialog for a virtual variable.

Click on, for example, Formula to enter a computation (Fig. 6-
14).

In the dialog you have available all variables already defined (tab
V1-10 and other tabs if more than ten variables have been
defined). Click on one of the variables to insert it into the for-
mula. Use the field Functions and operators to select a mathe-
matical or logical function (select the function and click on
Select function so that it is accepted into the formula field).
Where required add brackets (simply enter them via the key-
board) in order to obtain the correct computational sequence.
The syntax of the selected function is explained in the lower sec-
tion of the window. If required, zoom on this section to be able to
read the text easier.

Close the dialog with OK.
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i edit formula from virtual channel =NACN X
Y= -
¥1-10

W1 Timestamp W TensileForce left

W SystemTimeD C w7 Force right

W3 StartStop_Cond. RV TensileForce right

W Variable_4

Wh: Force left

System Variables

|Eyc|eEounter ﬂ Set |

Functions and Operators

LowerEqual -
MailSend F )

bl (m * |AND| OR

OLEZ2DateTime =
FIDController <

Y

choose Function i

b i ' alue:

[m] »

b alue)

The masimunn value of a variable will be “stored” and has to be resetted if required.
To rest thiz vanable, the settings have to be defined in “Event”

Q‘;ﬁ’ oK | = Cancel|

Fig. 6-14 Defining a computation (formula).

Defining CAN signals
You have a number of ways of defining CAN signals:
1. Create input signals using the virtual variable CAN_INPUT.
2. Create several input signals through the import of a Vector
CANdb database.
Define output signals through the :n" symbol.

Define output signals through the virtual variable CAN_OUT-
PUT (no longer recommended).

Defining single CAN signals

In the context menu for virtual variables select Add new vari-
able > CAN_INPUT. After a double click on the variable, you
can change the name and enter the CAN parameters (Fig. 6-15).
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A% Edit remate channel <WHEEL_SPEED_FL> = | B e
Tarme Yalue
0 Mame WHEEL_SPEED_FL
[& ‘ariable kind CaM
[ CaM UART UART #1
[& Use extended ID Ma
[& CaM message D [hex] 300
[& Byte order Motarola
[& CaM data format USINT1E
[& Start bit 7
[& Bitlength 15
L& Unit kmsh
= [¥ Scaling type Factor and Offgat
[ Factor 00625
[ Offzet 0
B @ D ata format settings
¥ Fomat FLOAT
[X Figldiength a
[¥ Precision 3
[& Data direction IMPUT
[¥ Use rules for read-access Mo
|
CAN DB... +f 0K ‘ 7< Cancel

Fig. 6-15 Example of a CAN signal.

Importing CAN signals from CANdb

By importing signals from a CAN database in Vector CANdb for-
mat (file extension dbc) you can create several variables in one
step. In the context menu for virtual variables select Add new
variable > Import CAN variables from DBC. Select the file
and in the following dialog (Fig. 6-16) mark the signals which you
want to import. Marking messages reads all signals, but you can
also mark individual signals.

457 Select CAN Signal .. =n| Wl <
10 [hex] Mame DLC Sende... Start-bit | Length  Byteorder  Datatype  Factor  Offset | Minimum | Maximum - Unit Receivername
+# [ &CO EMNGIME_TEMP_&ND_B&.. 8 ECS
ESI e R GEMER&L_STATUS_ABS g ABS
[ERES | | | | | [ 1 | |
“ Signal  WHEEL_SPEED_RR 48 18 Motorala  USINTIE 00625 0 a 300 km/h Wector__dx
“ Signal wHEEL_SPEED_RL 32 18 Motorala  USINTIE 00625 0 a 300 km/h Wector__dx
“ Signal wHEEL_SPEED_FR 18 18 Motorala  USINTIE 00625 0 a 300 km/h Wector__dx
“ Signal  wHEEL_SPEED_FL a 18 Motorala  USINTIE 00625 0 a 300 km/h Wector__dx

# [ 100 THROTTLE g ECS

# [ 1A0 EMNGIMNE_SPEED_&ND_T.. 8 ECS

# [ 120 EWNGINE_TORQUE_REQ_... 8 ABS

C:A\Users\Downloads\DEMO.DBC r -
53 Signals loaded o DK | 75 Cancel

Fig. 6-16 Selecting CAN signals or messages.
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Defining CAN outputs

Mark the Test Controller and click on the :n" symbol to call
the dialog. In the dialog (Fig. 6-17) specify which signal is to be
output on which CAN bus and how it is to be output.

Variable

L A

1\,.,?. CAM configuration

=

S

(=)
W1 Timestamp ™
W2 WHEEL_SPEED_.. [
W3 WHEEL_SPEED_.. [
W4 WHEEL_SPEED_.. [
W5 WHEEL_SPEED_.. [
VE: Load_Cell 2
W Force left v
W8: TensileForce left [
3: Force right v
W10: TensleForce right [

A S e R =

1D [hex]
300
3m
302
303
304
308
306
307
306
307

T extended Frame

ST T T T 171 Remote Request

o= =]
B 2| =
7 £ Si=| 5
ElOE |32 I T E8 5 3 3
g & = £ £ £ - i &8 5 F X
@ © £ B B = . £ & £ x x| = om o=
T OB BB 5 wiene 5 % 5 own Mas EIZE] 2 2| =2
Intel - USIMT, 0 B4 send @ only whenalue changes 1 o0 1] [T ioi& el 0 255
Intel - FLOAT 0 32 send  only whenalue changes kmdh - 1 o0 1] T ioi8 el 0 255
Intel - FLOAT 0 32 send  only whenalue changes kmdh - 1 o0 1] T ioi8 el 0 255
Intel - FLOAT 0 32 send  only whenalue changes kmdh - 1 o0 1] T ioi8 el 0 255
Intel - FLOAT 0 32 send  only whenalue changes kmdh - 1 o0 1] T ioi8 el 0 255
Intel - FLOAT 0 32 send  cyclic 1000 kg 1 o0 1] T ioi8 el 0 255
Intel - FLOAT 0 32 gend  onlywhenalue changss. -~ M 10 BI0004 BI0426 [ 0 & dmel 0 255
Intel © FLOAT 0 32 send | only when'alue changss W 10 10 10 v 0 &8 Intel 1 255
Intel | FLOAT 320 32 send | only whenWalue changss M 10 B10004 BI0426 [ 0 & dmel 0 255
Intel © FLOAT 0 32 send | only when'alue changss W 10 10 10 v 0 8 Inel 2 255
\VJ 0K /< Cancel

Fig. 6-17 Defining output signals for the CAN bus.

The example in Fig. 6-17 illustrates several variants for transfer-
ring data:

1. The variable V6 (Load Cell) is output continuously (Writing
rule: Cyclical) on CAN 1 with the CAN ID 305; the Cycle
time is 1000ms.

2. The variables V7 and V9 (Force left/right) are output in one
message with the CAN ID 306 when one of the values
changes. Here, the variable V7 occupies the least significant
32 bits (Start bit: 0), the variable V9 the most significant bits
(Start bit: 32).

3. The variables V8 and V10 (TensileForce left/right) are output
via the CAN bus connected to USB 1 (refer to Section 6.1.2.3,
Setting up a further CAN bus interface via USB, page 42)
when one of the values changes. The CAN ID is in both cases
307, i.e. the signal is multiplexed. The information of which
signal is transferred is embedded in the MUX value (1 or 2).
The value is transferred in the Intel format with the MUX
start bit 0 and the MUX length 8 bits. You can mask out cer-
tain MUX values via the MUX mask (not used here).

i Tip

For the output signals defined here a Vector CANdb file is auto-
matically produced in the project folder if you activate the option
Create CAN DBC file using the menu Extras > Settings and
Project settings.
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Variable for computational results from a logger

In order to be able to output computations from a logger (refer to
section Create statistics or arithmetic channels, page 77) or to
use them in other computations, you have to “pack” them into a
virtual variable.

In the context menu for virtual variables select Add new vari-
able > LOGGER_INTERNAL.

iz Edit remote channel <LoggerntVars =NACH X
Marme Walue
L& Mame Loager nivar
L& Variable kind Loggervariable
¥ Logger D atalogger_1
[ Varable type Logger-variable
L [variable Force right_Min |
L& Unit Farce left
= [¥ Scaling type TensileForce left
Force right
[¥ Factor
[ Oifset Force right_Max
& Enor generation on failure Force right_svg

Farce rnight_SDewv
TengileForce right

¥ Enor handling at zensor failure
= @ D ata format settings

[¥ Format SINT32

¥ Fieldlength 8

[¥ Precizion 3

[¥ Data direction INFUT
L& Use wiles for read-access Mo

-~

-

\V/" 1].4 ‘(’( Cancel

Fig. 6-18 Configuration dialog for an internal logger variable

Select the logger which computes the variable and state the vari-
able. All available (defined) variables are shown in the list (Fig. 6-
18). Specify the data format, how the value is to be transferred
and note which output is provided for this (with EtherCAT or
Modbus/TCP you have to use at least two bytes).

Variable for the status of a logger

You also create a variable for a logger status in a similar way as
for a variable for computations from a logger.

In the context menu for virtual variables select Add new vari-
able > LOGGER_INTERNAL. Then specify Logger status as
the Variable type.
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i Edit remote channel <LoggerIntVar> @m
Mame Yalue
-~ [X Mame Loggerlrty ar
¥ Variable kind Loggervariable
- [¥ Logger D atalogger_1
- [¥ “ariable type Lagger-state
- [ State | Enabled -]
¥ Unit Mails sent [«
B [F Scaling type FTP sent
Destination
(¥ Factor Destination size
Lo [ Difset [ estination remaining EI
-~ ¥ Emor generation on failure gg?;':;&'g;lgsg”um
- [& Emor handling at sensor failure D atasource achual size |3
=5 @ Diata format zettings
- [¥ Farmat SINT32
[ Fisldlength ]
: - [F Precision 3
- [ Data drection INPUT
-~ [F Use rules for read-access Ma
v’ oK | ?{ Cancel |

Fig. 6-19 Configuration dialog for a logger status variable.

You then have numerous possibilities available in the Status
field. For example, you can use the variable to check whether the
logger is active (enabled), whether the start or stop trigger has
occurred, how many files have been saved or also how much
space is still present on the target drive (refer to Explanatory

table of terms).

Status Explanation Parameter
Indicates whether a data logger is acti- 1 = Data logger saved
Enabled
vated 0 = Data logger not saved
Loddin Indicates whether the data logger is cur- | 1 = Storage process is active
gging rently saved 0 = Storage does not take place
1 = Start tri i ti
Start trigger Indicates whether a start trigger is active art trigger is actve

0 = Start trigger is not active

Stop trigger

Indicates whether a stop trigger is cur-
rently active

1 = Stop trigger is active
0 = Stop trigger is not active

Saved files

States how many files the data logger has
saved since the function was activated.
This is not the number of files which the
data logger has created since switch-on or
shipment.

File progress

Filling level of the current file (0 - 100%).
100% signifies that the file is complete
(setting of Size of a single file).
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Status Explanation Parameter
. Storage length of the current logger
Trigger progress -
gger prog file in percent (0 - 100%)
. Number of mails sent since the function
Mails sent . -
was activated
FTP sent Numl?er of files sent by FTP since the ~
function was activated
Index of the target memory (from the list
of target memories) on which storage is
currently taking place. The index of indi- | Example:
vidual target memories is shown with the | SDO = Index 0
Target

status information of the test controller.
In the mode Automatic drive selection
you can find out to which memory writing
is currently taking place.

USBO = Index 1
USB1 = Index 2

Target size

Total capacity of the memory in bytes.
This is a fixed size which only changes
when you connect another memory. Refer
also to the following parameters.

Target remain-
ing

This indicates how many bytes are still
free on the memory medium to which
writing is taking place.

Target occupied

This indicates how much space is already
taken up on the current target memory (0
- 100%).

Data source
overflow

Here, the value 0 should always be read.
Otherwise (=1) the data are lost. The
value states the number of overflows of
the ring buffer.

Data source cur-
rent size

This indicates how many bytes were in the
ring buffer the last time the data logger
wrote to it. The indication should always
stay the same. If it becomes larger, then
an overflow of the buffer memory is immi-
nent.

Data source
capacity

Maximum capacity of the ring buffer in
bytes. This is a fixed size.
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Status

Data source
maximum size

Explanation

This shows the size of the largest packet
that has been fetched from the ring buffer
by the data logger. The value remains
valid as long as no buffer overflow occurs.
The value is reset when the data logger is
deactivated.

Parameter

Post-processorl)

overflow

Here, the value 0 should always be read.
Otherwise (=1) the data are lost. The
value states the number of overflows of
the post-processor.

Post-processorl)

current size

This indicates how many bytes were in the
post-processor the last time the data log-
ger wrote to it. The indication should
always stay the same.

Post-processorl)

capacity

Maximum capacity of the post-processor
in bytes. This is a fixed size.

Post-processorl)

maximum size

This shows the size of the largest packet
that has been fetched from the post-pro-
cessor by the data logger. The value
remains valid as long as no buffer over-
flow occurs. The value is reset when the
data logger is deactivated.

1)

Post-processor: When a data logger is not operating at the same speed as its data source,

i.e. the ring buffer, or if data is being computed in the logger, the Q.brixx station produces
a post-processor. The logger fetches its data from it. The post-processor and the ring buffer

are therefore are memories where one directly follows the other.

6.4.5

Modbus interface

Sensor address

Defining Modbus RTU signals

In the context menu for virtual variables select Add new vari-

able > MODBUS_RTU.

In Fig. 6-20 the USB-to-RS-485 converter ISK 103 is used to
access the Modbus interface: USB 1 (refer to Section 6.1.4,

page 48).

Address of the receiving or transmitting bus device.
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Modbus register type

Registers

Modbus rules/
writing rules

Modbus data format

Scaling

Behavior on sensor error

Data format
(in the Q.brixx station)

J'\,..?_ Edit rermote channel <bodbus= EI@
TName Walue
[& Mame todbus
[& “aiable kind Modbug RTU
[¥ Modbus UART USE1
[& Sensor address 1
[& Modbus register type Read holding register [code: 3]
[& Register 33
= [ Modbus contral cyclic
[ cyclic time [ms] 1000
[& Modbus data format FLOAT
[F Unit %
+- [ Scaling type Factor and Offset
= [& Enar handling at sensor failure Diefault Walue
[¥ Default walue 0
=) D ata format settings
¥ Fomat DOUELE
[X Figldlength ]
[¥ Precision 3
[& Data direction INPUT
[¥ Use rules for read-access Mo

\Vf 0K (’( Cancel

Fig. 6-20 Variables for Modbus signal.

Depending on whether a value is to be read or written, you have
to specify the appropriate Modbus register type in the dialog. For
inputs usually the hold registers from 30,000 onwards are used
and for outputs the registers from 40,000.

Here, you specify the register address to be used (from the range
defined above).

Specify how values are to be read and written: Cyclical, only
with a change of the value or on request (via host). With Fast the
values are processed at the system cycle frequency (refer to
page 39).

If you select Cyclical, you then have to state the Cycle time.

Specify in which format the value is to be transferred on the Mod-
bus. The FLOAT format requires four bytes and therefore two
registers.

Here, if required, you can scale the value transferred on the Mod-
bus.

Here, you define the value to be displayed when the Modbus
device no longer supplies any values.

Here, you define in which format the value is provided in the
Q.brixx station and whether it involves an input or output (data
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direction). For example, you can convert a FLOAT value on the
Modbus into DOUBLE, i.e. a 64-bit value (double precision). Note
that the formats must have at least two bytes in order to be able
to fully transfer the Modbus information.

Reading/writing rights Here or using the context menu of the Test Controller and
Assign read/write accesses, define whether the variables are to
be available for other interfaces. Then activate the access (Read
or Write) for the relevant interface.

Online tools

Read data buffer (with measurements)

Click on or use File > Read online data buffer from con-
troller to be able to read out and view all values from the ring

buffer.
& tbuffer.dat - test.viewer Pro-Cnline 241 o o T S
File Edit View Settings Extras Online 7
=E Q& oR =H & 7
DatedTime: 27 Octaber 2014 16:32:26
$hufferd
= Force left — Force right
kM
E””WWWWWWW
500+
400 -
300+
200+
100+
0
] 3 10 15 20 25 30 35 40 45 a0
s
Variable Value Comment
-~
Bereit Merm: 7.25 MB

Fig. 6-21 Display of the buffer content with test.viewer.

You can carry out further settings using the menu and symbols,
e.g. display the channel list, show the spectra or transfer a live
stream of data.
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Displaying measurements

Click on or use File > Read online values from control-
ler to be able to view the values of your variables. If you have
defined appropriate variables, you can also set initial values in
this dialog.

- ~

4% View values .. Qu.station 101 DT <Darmstadt> @192.168.100.13 =S X
Controller - @192, 168.100.13 ZerofTare | Walue
= Pl Intemal
WV Timestamp [(#1] 4 E774341E17
%W StarthStop_Cond. [#2] ]
= & Slave RS 485" #2 Cycles counter:614700 / Errors counter.0
= | Errors counter:0
W Force left [(#3) 51653 K
W TensileForce left [#4] 3081.3M
# 0 G.bloxs 4101 @3 [TestStand3) Errors counter:0
I Showsalues in hex-format. |Tare j Zero/Tare |
nline SetRTC.. ‘ Clear all counters ‘ V"’ DK

.

Fig. 6-22 Dialog for displaying the variable values.

In the dialog click on Show online graphics to display the val-
ues in a graph over time.

Reading module information

Click on E or use File > Read online module info from
controller to be able to display information such as the address
or serial number of your system.

iy View file content: #actual.sta_mod

Display slaves info:

UaRTIndex 1
Address 2 3. blows 4107
Address 3 . bloxx A701

ok” CDEYV:EUARTA 05y-x00.40/£00.50 APPY-a00.61 SNR-FFO0113 5TA-020000000000
okK® DEV:ELARTI 54«00 400050 4PF-a00 51 SHR-FFIT 5T4-020000000000

Fig. 6-23 Display of the module information.
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Reading status information
Click on E or use File > Read online status info from con-
troller to display status information of your system.
( p,,..?_ View file content: #actual.sta_mod = | B |- |
Display state info:
GEMERAL STATES:
HEALTH: 5¥5_Act=7981% / 55 _fwer=T4.33% / AT _4ct=38.79% / AT _twer=38.81%
MEASUREMENT MODE ACTIVE
RUN STATES:
NTP CLIENT ACTIVE
FTP SERVER ACTIVE
DATA LOGGER ACTIVE
LOGGER STATES:
Logager 0 Dratalogger_1 Aot 1 Dest: ) Log: 1 TOr: 0 TOf: 0
T¥al: 0.000 File: 0 Trig: 0 Stor: 0 Mails: 0 FTP: 0
DEVICE STATES:
DATA DRIVE Mame: Flash (hd0l Files: 0 Size: 1033166848 Load 8.0
ERROR STATES:
SWBRNIMG:: [ StationD atalogger_0 -4405 Failed to request free storage space
<ERROR:: [)StationD atalogger_0 -4401 Buffer averrun detected!
7
«f DK
Fig. 6-24 Display of the status information.
Explanation of logger information
Act States whether the logger is activated (1) or not (0).
Des Target memory, e.g. sd0 (SD card).
Log States whether the logger is currently recording (1) or not
(0).
TOn States whether the start trigger is active (1) or not (0).
TOff | States whether the stop trigger is active (1) or not (0).
TVal | Shows the current value of the trigger variable.
File States the size of the current file in percent (0 - 100%).
Trig States the progress of the current trigger process in per-
cent (0 - 100%).
Stor | States how many files have been saved since starting the
logger.
Mails | States how many mails have been sent since starting the
logger.
FTP States how many files have been sent since starting the
logger.
Vers. No. 1.5
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Procedure

Firmware update

Recently purchased modules or Test Controllers always contain
the latest firmware, i.e. the software in the modules or Test Con-
trollers is the current version. However, if you want to combine
these modules with older modules and/or Test Controllers, you
must update all older modules or Test Controllers and it is essen-
tial to update your software to the latest version, because other-
wise disturbances in operation due to a communication failure
may OCCur.

The current firmware is in each case included in the latest instal-
lations of the programs ICP 100 or test.commander. Here, the
program licenses apply to all versions of a program. If required,
download the latest versions from our web site: www.gantner-
instruments.com. You will find the programs under Software >
Download.

Firmware update for Q.brixx station

Before a new installation is carried out, uninstall the existing ver-
sion using the Windows Control Panel. Install the latest version of
the test.commander so that you can also install the latest version
of the firmware on your PC.

1. Inthe program test.commander select Utilities > Controller
firmware update.
The network in the segment of the PC address is searched and
the Q.brixx station Test Controllers which are found are dis-
played in the window. If no Test Controller is found, you may
have to enter the address manually or set the IP address of
your PC to the segment used by the Test Controller; refer also
to Chapter 5, Q.brixx station connection, page 23.

2. Mark the Test Controller to be updated and click on OK.
The update tool is started and the Test Controllers present in
the network are displayed again.

3. Mark the Test Controller to be updated and click on Update.

The Windows file dialog is opened and shows you the latest
firmware version available on your PC. (After the installation
of the latest version the latest firmware is also installed. The
version is found from the ID number of the Q.brixx station
(module ID number)).

4. Mark the newest of the available firmware versions (if neces-
sary, switch to the detailed view) and click on Open.
The update process is started. Wait until the update has fin-
ished.

5. Click on OK and close the window of the update tool.
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Wait until the Q.brixx station has finished the restart. The firm-
ware update is now completed.

Firmware update for modules

Install as required the latest version of the test.commander so
that you can also install the latest version of the firmware on your
PC.

Procedure 1. In the program test.commander select Utilities > Module
firmware update.

2. Make sure that the settings with regard to the interface used
are correct: Options > Communication settings.

3. Search for the Test Controller or the modules: Find modules.

If the modules are connected via a Test Controller, in the next
window mark the Test Controller to which the modules to be
updated are connected and click on OK.
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Recording with the data
logger

The Q.brixx station Test Controller enables you to save up to four
sample rates in up to 20 data loggers. First, you specify how
many sample rates you require (and associated data buffers).
Then specify for the individual channels (UARTSs) which sample
rate it is to be used. In the third step you define the settings for
the logger(s).

u IMPORTANT

The settings of the channels to be recorded are based on the
channel names. When you retrospectively rename channels, the
(old) channel names are no longer found and the relevant chan-
nels are deactivated.

The settings are made via the system view (allocation of the chan-
nels to the sample rates) and via the following context menus of
the Test Controller:

¢ Settings for sample rates and data buffers,

* Logger settings for creating and setting the data loggers.

n IMPORTANT

The configuration files are not completely downwards compati-
ble. Therefore, check all the settings (logging rate, recording
modes, etc.) and the variables if you have carried out a firmware
update of the Q.brixx station Test Controller and then loaded an
old project.

Setting the sample rates (and data buffers)

Call the dialog via the context menu Settings of the Test Con-
troller (Fig. 7-1).

For each sample rate you also have to define a data buffer (ring
buffer) which accepts the (original) values. Whether and how
these values are processed later in the logger or via, for example,
EtherCAT is not relevant here. You can, for example, use two
data loggers and then “fill” one with the original sample rate and
the other with a reduced data rate (= logging rate) (refer to Log-
ging rate, page 78).
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Number

Sample rate #1 to #4

o Qustation 101 DT 192.168.100.1 (@192.168.100.45) ... l == i",_?—]
ame Walue
#- [5 Seftings
4 E-_g Slave interface
+- 55 Huostinterface
+ Eg USE devices
= @ Sample rate
[¥ Count: 3
= @ Sample rate #1
[& Mame Fast SampleR ate
[& Sample frequency 10000 Hz
[ Buifer size [Bytes]: B000000
= @ Sample rate #2
[¥ Mame Slow SampleR ate
[& Synchronization source intemal
[¥ Sample frequency E2AHz
[& Timestamp type System-time DC
[& Buifer size [Bytes]: 110000
- 55 Sample rate #3
|
-\\‘.‘fp OK | (’( Cancel

Fig. 7-1  Setting the sample rates.

Enter the required number of sample rates if you want to use
more than one sample rate (up to 4 are possible).

You should only use one sample rate per UART, especially with
analog signals. Two sample rates which are to operate through
one UART (one bus system) may otherwise lead to (small) inaccu-
racies in the time pattern of the measurements. If required, you
can write single modules to a logger at a reduced data rate. How-
ever, the data buffer should be filled with the same sample rate
for all modules of a UART. If in doubt, use the higher sample rate
for all modules of a UART.

Sample rate #1 (ring buffer 1) has a special role: It is the basic
sample rate of the system. No other sample rate can be higher
than sample rate #1. At the same time it provides the synchroni-
zation base for the other sample rates, i.e. the other sample rates
are synchronized to this sample rate such that at time points
where a measurement is taken at a lower sample rate, this occurs
at a time point where a measurement also takes place at sample
rate #1. This is not the case only in the Synchronization
source: external operating mode.

u IMPORTANT

If you change sample rate #1, the system cycle frequency is also

changed such that the ratio between the sample rate and the sys-
tem cycle frequency remains the same. For example, if you have

chosen a system cycle frequency of 1000Hz and you then reduce
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Name

Synchronization source

sample rate #1 from 10,000Hz to 1000Hz, then the system cycle
frequency is also reduced to 1/10, i.e. to 100Hz.

You can leave the default name as it is or use the purpose of the
sample rate in the name, e.g. SlowSampleRate.

With the first sample rate you cannot specify a synchronization
source, because this sample rate is the basic sample rate of the
system.

In the default setting the other sample rates are internally syn-
chronized to sample rate #1. With sample rates 2 to 4 you can
however synchronize to an external signal (Synchronization
source: external), e.g. to obtain a measurement with angular
synchronization (refer also to Section 7.4.3, Angular synchronous
measurement, page 95). In this case you have further entry fields
available:

* Digital input

Specify on which digital input the synchronization signal is
applied. Note that DI1 may be used for time synchronization.

« Edge
Specify whether the rising or falling edge is to be used.

¢ Debounce

If the signal is produced by a mechanical contact, you can
suppress the effect of a bouncing contact with this setting:
The level is only valid when - at a sampling frequency of 48
MHz - the number of samples (measurements) specified here
exhibit the appropriate level (edge-dependent).

¢ Minimum time between two syncs

With this setting you can also suppress bouncing or brief dis-
turbances after an edge: The next edge is only monitored
when the time specified here has expired. Make sure that the
specified time is shorter than the time between consecutive
pulses at the highest rotational speed.

* Reset mode for time stamp

Here you can reset the cycle counter in particular for angular
synchronous measurement. The Q.brixx station supports four
different methods and further entry fields are provided
depending on the method:

- Reset on reference pulse, i.e. when a (single) pulse occurs
on the Reset input for time stamp (digital input), the
counter is reset and the counting starts at one again with
the next pulse.

- Reset on reference gap, i.e. pulses must also occur on the
Reset input for time stamp simultaneously with the syn-
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Sampling frequency

Time stamp

Buffer size

chronization pulses. If the pulse on the reset input is miss-
ing, the counter is reset.

- Reset on falling edge of the reference signal, i.e. when the
level on the Reset input for time stamp goes low, the
counter is reset.

- Reset on rising edge of the reference signal, i.e. when the
level on the Reset input for time stamp goes high, the
counter is reset.

Whether, when and which method you can use, depends on

the angle sensor used. Usually a pulse on reaching the zero or

starting position is output, i.e. depending on the length of the
pulse, you can use the first or one of the two last methods.

No sample rate may be higher than sample rate #1. The sampling
frequency is the frequency with which the measurements are
read into the Test Controller and it is independent of the logging
rate of the logger.

The updating of virtual and system variables is not determined by
the sample rate, but rather by the cycle frequency of the system;
refer to System cycle frequency in Section 6.1.1.1, page 39.

With sample rates 2 to 4 you can also specify a different time
source as the System time DC (distributed clock). The system
time is always used in sample rate 1. This must not be changed.

Specifying Cycle counter is practicable, for example, with exter-
nal synchronization, in particular together with a reset signal;
refer also to Synchronization source, page 71. With this you can,
for example, implement a channel containing a measure for the
angle and which is set to zero after each full revolution.

The data buffer operates as a ring buffer, i.e. the oldest values
are overwritten once the data buffer has been filled. Each data
buffer can be read simultaneously from several points: Up to 10
connections are possible just over Ethernet alone.

Overall, for all (four) data buffers you have 200 Mbyte available.
This space can be divided as required. You can, for example, allo-
cate half the space to one data buffer and divide the rest between
the other three or use the whole space for one data buffer.

The size must always be given in bytes, so therefore check the
number of zeros. A figure given in seconds or similar is not possi-
ble.

Assign sample rates to the channels

In the Sample rate column of the system view select the
required sample rate for the relevant channels (Fig. 7-2). Later in
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the logger settings only the channels are shown which are being
acquired with the corresponding sample rate.

Create further loggers,
delete loggers

—

Type Connection | Range Samplerate

Q.station 101 DT 192.168.100.1 [@192. .

System vaniables

Digital 140

Wirtual variables

(. blowx 4107 [2/2) TestStand3
A V5 Senzorl 51000, 51043 N Fast SampleRate
A Ve 10,000 ... 10.000 v Fast SampleFate

— g 0 OblowxA107 (32 TestStand® T T T B

B VT Sensor 51000, 51043 N Slow SampleR atel
Aove 2 10,000 ... 10,000 v Slow SampleR ate

-

Fig. 7-2  Selection of the sample rate, FastSampleRate and
SlowSampleRate illustrated (you define the names when
setting the sample rate).

You should only use one sample rate per UART for all modules,
especially with analog signals. Two sample rates which are to
operate through one UART (one bus system) may otherwise lead
to (small) inaccuracies in the time pattern of the measurements.
If required, you can write individual modules to a different logger
at a reduced data rate (logging rate). However, the data buffer
should be filled with the same sample rate for all modules of a
UART. If in doubt, use the higher sample rate for all modules of a
UART.

Logger settings

The data loggers store the acquired values in one or more files.
The storage speed (Logging rate) need not necessarily be the
same as the sample rate. The files can be saved internally or
externally and you can also set that the storage medium can be
changed during the measurement. Refer also to Section 7.4,
Examples page 87ff.

You call the logger settings via the context menu of the Test Con-

troller or via fil.

At least one logger is always present and you can create others

with a click on "= above in the window. A maximum of 20 log-
gers is possible. A click on * deletes the relevant logger with all
the settings (for safety you are queried again before deletion).
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( e Logger configuration =R \
Loggerl :
| Data source: Logger type: Logger name: Logger status:
Fast SampleRate + | |Continuous v | Datalogger_#1 v activated
Available variables -
= Fast SampleH ate T
R Timestamp
O R Digital Output 1 Logging rate 300 Hz
[0 R Digital Output 2
O R StarttStop_Cond.
R Sensor
R W =
Size of a single file 300 sec
4} Expert settings | < Ccancel |
Fig. 7-3  Logger settings (example of a continuous logger).
7.3.1 Settings in the header section for Loggers 1 to 20

Data source

Logger type

Here you select which sample rate (which data buffer) is to be
used for this data logger. You choose how many values are actu-
ally stored via Logging rate; refer below.

BN iMPORTANT
The selection of any other data source resets all settings of the
logger (right side).

Here, you choose between Continuous, Triggered and Event-
based. After selecting Triggered or Event-based other options
are displayed so that you can set the trigger conditions.
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= Fast SampleH ate
Timestamp

Digital Output 1

Digital Output 2

Sensorl

1

EEO0O0OF
AODOODO00

( i Logger configuration @M
-Loggerl : E‘
Data source: Logger type: Logger name: Logger status:
|Fast SampleRate |z|| |Triggered E“ |Fast_wi1h_Trigger Iv activated
Available variables -

StartkStop_Cond.

Logging rate 300 Hz

m

Start trigger: condition
| startstop_Cond. > 0.5

Stop trigger: condition

| StarteStop_cond. <05 |

Post
trigger

Pre trigger:

120 zec

Size of a single file
|==——— Logging length | 15000 Data sets —_—

4} Expert settings

J 114 | x Cancel |

Logger name

Fig. 7-4  Logger type Triggered.

You will find the special settings for triggered or event-based
measurements in Section 7.3.5, page 84; the settings applicable
to both logger types are explained in the following sections.

We recommend that a name is assigned which characterizes the
purpose of the logger, e.g. SlowMeasurement or ForceTrigger.

Using placeholders in the logger name, you can define a suitable
folder structure for your files. Specifying %YYYY-%mm-%dd/
%HH/SlowMeasurement creates the following folder structure
if the first measurement of the first file was acquired at 8am on
25.01.2014:

\2014-01-25\08\SlowMeasurement...

Available placeholders

Flaces Meaning

holder

%a Day of the week, abbreviated Thu

%A Day of the week Thursday
%Db or %h Month name, abbreviated Aug

Q.series
Gantner Instruments GmbH

75



7

Recording with the data logger — Logger settings

Gantner

instruments

2332; Meaning Example
%B Month name August
%c Date and time TEHS?%QZ 2014
%C The first two places of the year 20
figure
%d Day with two figures 23
%D Date in short form 02/23/14
%e Day with two places 1
(space character as prefix)
%F Date (long form) 2014-02-23
% figure, wookbased | 1
%G Year figure, week-based 2014
%H Hour in 24-hour format 13
%l Hour in 12-hour format 01
%j Day of the year 235
%m Month with two figures 02
%M Minute 55
%p AM or PM PM
%r Time in 12-hour format 01:55:02 pm
%R Time in 24-hour format 13:55
%S Seconds 02
%T Time to ISO 8601 1:55:02 PM
%u ]()l\iz;;;;iv;?ek to ISO 8601 4
Wo g e S o |
%V Calendar week to ISO 8601 34
D f the week as number
| ey o
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Logger status

7.3.2

Place-
holder

Meaning Example

The last two figures of the year

14
figure

Y%y

%Y Year figure 2014

Time offset with respect to
%z UTC time according to ISO +100
8601 in minutes

Time- .
%7 tilor?le zone name or abbrevia CDT

%% Percent character %

To use the logger with the following stated conditions you have to
select Activated here (default setting). If the option is not active,
the start/stop trigger is not evaluated. You can then activate or
deactivate the logger status, for example, using the arithmetic
function InternalLoggerControl. The logger status can also be
changed via the Expert settings; refer to Status, Section 7.3.4,
page 83.

Available variables

All channels which operate with the sample rate selected at Data
source are displayed. Select those which are to be recorded by
this logger.

Create statistics or arithmetic channels

If you do not want to record all values, but rather only statistical
values such as minimum or maximum, etc., open the context
menu for the variables (for the channel) and select the required
value. Add statistical values generates all possible values (min/
max/mean and the standard deviation) as subchannels. Blank
arithmetic generates a computation channel (formula). You have
the same functions available as with the virtual variables; refer
also to Section 6.4, Virtual variable, page 54.

Double click on the new channel to define the settings (Fig. 7-5).
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i edit logger variable <Sensorl_Max> o e
TName Yalue
[& Mame Senzorl_Max
[¥ Formula MAKNT)
[& Unit M
= @ Ewent
[¥ Onlogging intereal Mo
[& Onvarsble x> 0.5) RezetMintax
+- 55 Dataformat settings
[ Use rules for read-acoess Mo
|
\\‘.f" OK ‘ ‘?( Cancel |

Fig. 7-5  Dialog for the functions Maximum and Reset.

If you have created a blank formula, click in the field to the right
of Formula to call the input dialog. For the Max function illus-
trated in Fig. 7-5 you can either define that a variable or a digital
input controls the reset (the variable ResetMinMax in the illus-
tration) or that the value is reset after being stored at the logging
rate (In the storage interval:). Yes). In this case the logging
rate should be significantly lower than the sample rate. If neces-
sary, create a dedicated logger for such values; refer also to the
next section.

Example: Maximum function, sample rate 3000Hz, logging rate
5 seconds. With this setting the maximum is formed over 15,000
measurements in each case and is then stored (1 value).

Details in the record settings section

You will find the special settings for triggered or event-based
measurements in Section 7.3.5, page 84; the settings valid for
both logger types are explained in the following.

Logging rate

Here, you can define whether all values acquired with the sample
rate specified under Data source (refer to Sample rate #1 to #4,
page 70) are to be written into the data buffer or, for example,
only every 10th value. A value greater than the sampling fre-
quency is not permissible.

The sample rate should be an integer multiple of the logging rate.
For example, with a sample rate of 1000Hz select a logging rate
of, for example, 100, 200, 250, 500 or 1000Hz, not however 300,
400 or 750Hz.

Select either Hz and enter the sampling frequency specified for
the sample rate or enter a value lower than the sampling fre-
quency. In order to store only every 10th value, enter 400 Hz for
a logging rate (sampling frequency) of 4000 Hz.
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If you only require a few values, e.g. you only want to save one
value every ten seconds, specify Seconds for Logging rate and
10 for Value.

Size of a single file

Depending on the logger type, you can specify the size of a file as
the number of data records, in seconds, bytes or as a number of
events. A data record corresponds to one measurement over all
channels activated at Available variables. When the specified
value is reached, a new file is started if the recording has not yet
finished.

n IMPORTANT
Up to 10,000 files can be saved on a storage medium.

If you specify the file size as “rounded” time, the individual files
are started at rounded times (rounding time feature). For exam-
ple, if the first recording starts at 13:33:43 h and 150 seconds
(2.5 minutes) are recorded, then writing to the first file only takes
place up to 13:36:00h and then a new file is started, so that all
other files start at “rounded” times (13:38:30h, 13:41:00h, etc.).
This is also taken into account with a specification in minutes.
However, if you specify, for example, 55 seconds, “rounding”
does not take place to 60 seconds, i.e. “non-rounded” starting
times occur.

The file name is formed from the logger name and the date and
time of the first measurement. Using placeholders in the logger
name, you can define a suitable folder structure for your files;
refer to Logger name, page 75.

Event length
This setting is only available with the Event-based logger type.

You define over how many data records, how long or how many
bytes per event are to be logged. A data record corresponds to
one measurement over all channels activated at Available vari-
ables.

Storage length
This setting is only available with the Triggered logger type.

You specify the total time over which logging is to occur. The set-
ting is independent of the size of the single file, i.e. it can be
smaller or larger. If the value for the Storage length is greater
than the size of the single file, then several files are written.
Refer also to Section 7.4, Examples.
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Type of storage

The type of storage determines how and in what sequence writ-
ing occurs to the target memories specified in the following. Now
you have basically four options:

1.

2.

Storage on the newly connected data medium

Storage of the data occurs on the first available data medium
with the file size specified under Size of a single file. If no
further space is available here, the oldest two files are deleted
and overwritten with new data (one file more is always
deleted than written new in order to maintain a reserve).
When you connect a second data medium, the storage on the
active data medium is terminated immediately and is written
to the new data medium. You can remove the old data
medium once the blue LED (RUN) no longer flashes rapidly
(storage has then terminated). Otherwise the copied files may
be damaged, refer also to Section 4.3.1.2, Storage to external
memory running, page 19. This means that you can write
alternately to two storage media, e.g. an external hard disk
and a USB storage medium.

Automatic drive selection

Storage of the data occurs on the first available data medium
in the list with the file size specified under Size of a single
file. If no further space is available here, the next data
medium in the list is used. If all available data media are full,
the oldest two files in all data media are sought. They are then
deleted and the relevant data medium is used further. The
oldest files of this data medium are always deleted and over-
written with new data (one file more is always deleted than
written new in order to maintain a reserve). With this option
all the specified data media are used like a single large ring
buffer.

To prevent the loss of data you have to read out the data via
the network before overwriting.

Moving files

Storage of the data occurs on the specified data medium with
the file size specified under Size of a single file. If no further
space is available here, the oldest two files on this data
medium are deleted and overwritten with new data (one file
more is always deleted than written new in order to maintain
a reserve).

When you connect another data medium, the data are moved
onto this data medium, i.e. they are deleted on the original
data medium. The transfer is indicated by rapid flashing of
the blue LED (RUN). You can remove the data medium once
the blue LED no longer flashes rapidly. Otherwise the copied
files may be damaged, refer also to Section 4.3.1.2, Storage to
external memory running, page 19.
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4. Copying files
Storage of the data occurs on the specified data medium with
the file size specified under Size of a single file. If no further
space is available here, the oldest two files on this data
medium are deleted and overwritten with new data (one file
more is always deleted than written new in order to maintain
a reserve).
When you connect another data medium, the data are copied
onto this data medium, i.e. they are retained on the original
data medium and are not deleted as in the case of 3. With the
selection of ... only new data only the data which has not yet
been copied are copied onto the newly connected data
medium.
The copying process is indicated by rapid flashing of the blue
LED (RUN). You can remove the data medium once the blue
LED no longer flashes rapidly. Otherwise the copied files may
be damaged, refer also to Section 4.3.1.2, Storage to external
memory running, page 19.

Protected mode

The protected mode prevents unauthorized reading of your data.
For this you require a specially prepared data medium which is
coded to the Q.brixx station and the data medium used. In this
matter contact the Technical Support (refer to Chapter 9, Inter-
national Sales and Service, page 105), who will then produce an
appropriate file for your storage medium using the details you
provide. After selecting this option, the data are only transferred
when a data medium coded in this way is connected. No data is
transferred when another data medium is connected.

Target memories

Storage of the data always takes place on the specified data
medium or on the first available medium where there are several
media. The maximum size of the internal memory (hd0) is

1 Gbyte.

However, we recommend that the internal memory is only used
with low data rates, because here the number of measurements
which can be saved per second is relatively low.

Otherwise select a USB drive or a network drive.

n IMPORTANT
Up to 10,000 files can be saved on a storage medium.

Whether and when writing to further media occurs depends on
the settings for Type of storage.
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B8 MPORTANT

If only one medium is specified, this medium must not be
removed as long as one of the loggers is active. Otherwise data
may be lost. With storage on USB make sure that the correct USB
interface is specified (refer to Fig. 4-1, page 17).

To facilitate the connection of several USB data media via a USB
hub you can select various ports for the relevant USB interface.

If, as in Section 6.1.3.4, Network drives, page 46, you have
defined one or several network drives, you can also define them
as the target memory: select the Name specified there.

Also send data to FTP server

In order to be able to send data to an FTP server, you must first
define the data for the FTP server(s); refer to Client settings in
Section 6.1.3.3, page 44. The data are sent when the Size of the
single file is reached.

Here, you select the FTP server.

destinations a S0-card -
2( deactivated =
2( deactivated =
K deactivated <

¥ Send data additionally to ftp-server

FTP server |[jlsEflssnnne

Fig. 7-6  Send data to an FTP server

B Tip

Using the variable SendFTPVirtualBufferFile, you can also trig-
ger the sending of a file to an FTP server. In this case you can
leave the entry blank.

Sending an e-mail

In order to be able to send e-mails you must define the possible
selections for the fields Address, Subject and Content; refer
also to Section 6.1.3.6, page 47. The e-mail is sent when the Size
of a single file is reached; the file is sent as an attachment.
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File storage mode

Status

Make selection
You call the logger settings via the context menu of the Test Con-

troller or via F¢l.

v Send an additional e-mail

Address |data@ganter-instruments.com ~
Subject |Data from logger 1 available <
Body |Flease transfer data from logger 1 i

Fig. 7-7  Sending an e-mail.

Activate Additionally send e-mail and select one of the settings
for the Address, Subject and Content.

Expert settings

With the expert settings you can perform various general settings
for any data logger. The default settings are suitable for most
applications, so only change them if necessary.

i Expert settings from <Datalogger_1: EI@
Tarme: Yalue

[& File save-mode buffered

[¥ Status activated

[& Marirurm files 10000

[& Masimum bytes 0

(& Masimum files in directory 10000

[ Delete files automatically activated

| ,:( Cancel

Fig. 7-8  Expert settings.

The buffered setting offers the fastest speed, but the operating
system decides when writing is to occur. In the settings with
direct, writing takes place directly without a buffer where possi-
ble, sync synchronizes the complete file system directly after
every time writing to a file occurs (directory structure) and fsync
only synchronizes the written file (updating where the file is
located on the storage medium).

This basically corresponds to the setting of the logger status
(Section 7.3.1, Logger status, page 77). In the Single shot mode
the logger is only activated once at the trigger event. Depending
on the setting for the file size, several files are also recorded as
long as the trigger event is present. After recording, the logger is
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Maximum files

Maximum bytes

Maximum files in the direc-
tory

Automatic file deletion

Start-trigger, event

deactivated in this mode and another trigger event is not
awaited.

You can also activate or deactivate the logger (again) in the Sin-
gle shot mode via the arithmetic function InternetLoggerCon-
trol.

This defines how many files can be created as a maximum by this
logger (0 to 4,294,967,295). The default setting is 10,000.

With this setting you can restrict the space in bytes available to

this logger (0 to approx. 1.8 - 1019, longest 64-bit integer num-
ber). Specifying 0 (default setting) corresponds to no restriction.

This restricts the number of files which can be created in a direc-
tory. The default setting is 10,000.

This deletes the oldest files once the space available on the stor-
age medium has been occupied.

Trigger and event settings

n IMPORTANT

You must measure the channel used for the trigger condition or
the event or the condition variable with the logger sample rate
(same sample rate). The channel must therefore be listed and
activated in the section Available variables.

The difference between Event-based and Triggered is that with
Triggered both start and stop occur via a trigger event, whereas
with Event-based only the start is initiated by an event (trig-
gered) and a stop trigger does not exist: The quantity of data
specified under Event length is always recorded.

You can specify a channel or a computation as the Condition for
the trigger. This can also be a channel, for which writing into the
variable occurs, e.g. via EtherCAT from a PLC or from test.con.
Click on the entry field to call the dialog for input. The field is dis-
played with a red font as long as no condition or an invalid one is
specified. Specify whether the variable has to exceed (>), under-
cut (<), be greater than or equal to (>=), be less than or equal to
(<=), be identical to (==) or only not the same as (!=) the speci-
fied value, so that the trigger or event is initiated.

n IMPORTANT
The start trigger must also be recorded.
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Stop-trigger

Pre-trigger

Post-trigger

Event length

Storage length

Click on Stop trigger to change over between Condition and
None. In the None setting storage is terminated when the stor-
age length is reached.

You can specify a channel or a computation as the Condition.
This can also be a channel, for which writing into the variable
occurs, e.g. via EtherCAT from a PLC or from test.con. Click on
the entry field to call the dialog for input. The field is displayed
with a red font as long as no condition or an invalid one is speci-
fied. Specify whether the variable has to exceed (>), undercut
(<), be greater than or equal to (>=), be less than or equal to
(<=), be identical to (==) or only not the same as (!=) the speci-
fied value, so that the trigger is initiated.

Bl mMPORTANT
The stop trigger must also be recorded.

Using a pre-trigger you can define that a certain time is also
recorded before the occurrence of the above defined start event.
The figure can be given in seconds or as a number of data
records. Click on Pre-trigger to switch the option on or off.

n IMPORTANT
The pre-trigger must fit into the buffer specified for the sample
rate; refer to Buffer size, page 72.

When you specify a pre-trigger, values are continuously recorded
in the internal memory. If the condition is fulfilled, the data pres-
ent here is stored in the logger file.

Here specify whether recording is to continue after the stop sig-
nal. The figure can be given in seconds or as a number of data
records. Click on Post-trigger to switch the option on or off.

n IMPORTANT
With repeated measurements the pre-trigger condition is only
evaluated again after the post-trigger has run.

This setting is only available with the Event-based logger type.

You define over how many data records, how long or how many
bytes per event are to be logged. A data record corresponds to
one measurement over all channels activated at Available vari-
ables.

Refer also to Section 7.4, Examples.

This setting is only available with the Triggered logger type.
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You specify the total time over which logging is to occur. The set-
ting is independent of the size of the single file, i.e. it can be
smaller or larger. If the value for the Storage length is greater
than the size of the single file, then several files are written.
Refer also to Section 7.4, Examples.
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Examples

The following includes configuration examples for frequently
occurring measurement tasks.

Continuous recording

Storage on a data medium, storage with or without data reduction

Continuous recording of all data is to take place. The values
acquired with sample rate #1 (StandardMeasuringRate was cho-
sen as the name) are to be written to a log file with a logging rate
of 10Hz (ten values per second) over 300 seconds in each case. If
the set sample rate #1 (StandardMeasuringRate) is higher than
the logging rate, data reduction occurs. A logging rate higher
than the sample rate is not permissible. Each file contains 3000
values per channel (300 seconds at 10Hz, Fig. 7-9).

i Logger configuration

Loggerl

Available variables

= Fast SampleRate
R Timestamp
R Farce left

R Farce right

) Expert settings

| Data source:
Fast SampleRate

=0 R TersileFores |t
W TensileFaorce lef_tax

= [0 R TensileForce right
W TensileForce rig_tax

Logger type: Logger name: Logger status:

» | |Continuous v || Datalogger_1 v activated

Logging rate 10 Hz

m

Size of a single file 300 sec

Storage type |automatic drive selection <

- logger stores to the first available device from the list
- devices may never be removed
- data access always via netwaork

destinations a SD-card -
*e USB1 v
- SR 2 -
K deactivated <

\‘FA 0K | 2‘( Cancel |

Fig. 7-9  Example of a continuous recording.
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The data are written to the SD card and must therefore be moved
from time to time from there to a different medium, e.g. via the
network. Otherwise, the two oldest files are deleted and overwrit-
ten with new data (one file more is always deleted than written
new in order to maintain a reserve).

Storage on several data media, storage with or without data reduc-
tion

Continuous recording of all data is to take place. The values
acquired with sample rate #1 (StandardMeasuringRate was cho-
sen as the name) are to be written to a log file with a logging rate
of 10Hz (ten values per second) over 300 seconds in each case. If
the set sample rate #1 (StandardMeasuringRate) is higher than
the logging rate, data reduction occurs. A logging rate higher
than the sample rate is not permissible. Each file contains 3000
values per channel (300 seconds at 10Hz, Fig. 7-10, page 89).

The data are first written to the SD card, then to the storage
medium on USB1 and finally to the storage medium on USB2
(refer to Fig. 4-1, page 17). If all available data media are full, the
oldest two files are sought. In the example they are located on the
SD card and are then deleted. Thereafter, the SD card continues
to be used; the oldest files of this data medium are always deleted
and overwritten with new data (one file more is always deleted
than written new in order to maintain a reserve). When all files
have been overwritten once, the next target memory is used, here
the storage medium on USB1.

With this option all the specified data media are used like a single
large ring buffer. To prevent the loss of data you have to read out
the data via the network before overwriting.
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#5 Logger configuration

| Data source:
StandardSampleRate

Available variables
= Fast SampleR ate
R Timestamp
R Force left
= D R TenzileForce left
W TensileForce lef_tax
R Farce right
=[O0 R TensileForce right
W TensilsForce rig_Max

-Q Expert settings

= [ ] [ |
Loggers \ar
Logger type: Logger name: Logger status:
~ | |Continuous ~|| |Datalogger_1 ¥ activated

»

Logging rate 10 Hz

m

Size of a single file 300 sec

Storage type | automatic drive selection <

- logger stores to the first available device from the list
- devices may never be removed
- data access always via network

destinations g Internal memary b
a SD-card 4
=< UsB1 v
?( deactivated =

=

W')" 0K | K Cancel

7.4.1.3

Fig. 7-10 Continuous recording on several data media.

Storage on last connected data medium, storage with or without
data reduction

Continuous recording of all data is to take place. The values
acquired with sample rate #1 (StandardMeasuringRate was cho-
sen as the name) are to be written to a log file with a logging rate
of 10Hz (ten values per second) over 300 seconds in each case. If
the set sample rate #1 (StandardMeasuringRate) is higher than
the logging rate, data reduction occurs. A logging rate higher
than the sample rate is not permissible. Each file contains 3000
values per channel.
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( i Logger configuration =NRE X ]
Loggerl \arh
| Data source: Logger type: Logger name: Logger status:
StandardSampleRate + | |Continuous v | |Datalogger_1 v activated
Available variables -
= Fast SampleH ate
R Timestamp
R Force left Logging rate 10 Hz
= [0 R TensileForce left
W TensileForze lef_tax
R Forceright
=[O R TensileForce right
W TensileForce rig_Max
Size of a single file 300 sec
Storage type |Save on new connected drive <
- data files are stored to the last connected storage device
- after plugging a new device, storage is stopped on the old
and continued on the new device
- gwitching progress is indicated by fast flashing blue LED
- remaving the old device is save after LED stopped flashing 1
destinations a SD-card =
s USBL -
) Expert settings V/’ oK | 7< Cancel |
Fig. 7-11 Example of a continuous recording (USBI1 is the left USB
interface; refer to Fig. 4-1, page 17).
The data are written to the first available storage medium (to the
Fig. 7-11 SD card or USB storage medium). You must therefore
promptly connect the second medium specified as the target
memory. Otherwise, the two oldest files are deleted and overwrit-
ten with new data (one file more is always deleted than written
new in order to maintain a reserve).
When you connect the second storage medium (Target mem-
ory), storage on the current medium is terminated, i.e. normally
a file containing less than 300 seconds is produced. The blue LED
(RUN) on the Q.brixx station flashes rapidly until the write pro-
cess starts on the new medium. With larger storage media detec-
tion may take longer, so it is essential to wait until the LED starts
to flash rapidly. When the blue LED flashes slowly again (this may
Vers. No. 1.5
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take longer than a minute), you can and must remove the first
storage medium. Remove the data medium only when the flash-
ing has stopped as otherwise the files may be damaged. The
changeover from one storage medium to the next takes place
when you connect a new medium.

Recording of a single event (repeated)

Control by start/stop condition and time limitation, storage on one
data medium, transfer on connection of another one

Recording is to occur when the variable Start&Stop Cond. is
greater than 0.5 (the variable is a digital input and contains the
value 0 or 1). Overall, measurement should occur until the vari-
able Start&Stop Cond. is again smaller than 0.5 or until 30 min-
utes have been recorded. Recording should take place at 10Hz.

With the settings from Fig. 7-12, page 92 the recording starts
when the variable Start&Stop Cond. is greater than 0.5. As long
as this is the case, a file is produced at 10Hz for each time for a
maximum of 5 minutes (Size of a single file) and then a new file
is started. When the variable Start&Stop Cond. is smaller than
0.5 or after 30 minutes at the latest (Storage length 1800 sec-
onds), the recording is stopped, i.e. the file last produced is gen-
erally smaller than 300 seconds.

When a new start-trigger then occurs, i.e. when the variable
Start&Stop Cond. is again greater than 0.5, the recording starts
again.

The data are written to the SD card (Target memory). You must
therefore promptly connect another storage medium, e.g. a USB
data medium. Otherwise, the two oldest files are deleted and
overwritten with new data (one file more is always deleted than
written new in order to maintain a reserve). When you connect
another storage medium, the transfer of the files begins. The blue
LED (RUN) on the Q.brixx station flashes rapidly until the write
process on the new medium has concluded. With larger storage
media this process and also the detection of the storage medium
may take longer, so it is essential to wait until the LED starts to
flash rapidly. Once the blue LED flashes slowly again, you can
remove the data medium (e.g. tap Eject on the display). Remove
the data medium only when the flashing has stopped as otherwise
the files may be damaged.
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i Logger configuration =NRE X
Loggerl oy
| Data source: Logger type: Logger name: Logger status:
SlowSampleRate + | |Triggered v | |Datalogger_1 v activated
Available variables -
= SlowS ampleR ate [with Timestarp)
R StartéStop Cond.
R Force left Logging rate 10 Hz
= [0 R TensileForce left
W TensileForze lef_tax
R Forceright
= [0 R TensieFores right Start trigger: condition
% TersileForce rig_Max StartiStop_Cond, » 0,5
Stop trigger: condition
StartBStop_Cond, < 0,5
i
Pre-trigger Past
.gg -
E—l =
Size of a single file 300 sec
|==———— Logging length 1800 sec —_—
Storage type |automatic drive selection <
- logger stores to the first available device from the list
- devices may never be removed
- data access always via network
destinations a SD-card ~
?( deactivated ¢
?( deactivated A
?( deactivated <
) Expert settings V/’ oK | 7< Cancel |

Fig. 7-12 Example of a triggered recording with time limitation.

Start and stop a measurement with pre- and post-trigger, storage
on one data medium, transfer on connection of another one
Recording is to occur when the variable Start&Stop Cond. is
greater than 0.5 (the variable is a digital input and contains the
value 0 or 1). However, the recording is to start before this event
and the recording should also contain the measurements of 30
seconds before this event. Measurement should continue overall
until the variable Start&Stop Cond. is again less than 0.5 plus a
run-on period of one minute. The other recording parameters are
as given in the previous example.
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i Logger configuration

Loggerl

Available variables

Ary
Data source:

SlowSampleRate

= SlowS ampleR ate [with Timestamp)
R StatiStop_Cond.
R Force left
= D R TenzileForce left
W TensileForce lef_tax
R Farce right
=[O0 R TensileForce right
W TensilsForce rig_Max

-Q Expert settings

Logger type: Logger name: Logger status:

Datalogger_1

~| | Triggered A [v activated

Logging rate 10 Hz

Start trigger: condition
StartRStop_Cond, = 0,5

Stop trigger: condition

StartfStop_Cond, < 0,5

Post
trigger

Pre trigger:

m

30 sec 60 sec
Size of a single file 300 sec
Logging length 1800 sec
Storage type |unprotected move ~

- data is stored directly to the selected device

- after connecting a transport device, all files are moved to the
niesw device

- move process is indicated by fast flashing blue LED

- remaving the fransport device is save after LED stopped flashing

a SO-card -

destinations

| 2‘( Cancel

Fig. 7-13 Example of a triggered recording with start and stop trig-
ger.

With the settings from Fig. 7-13, page 93 the values to be stored
are initially written to an intermediate buffer which is 30 seconds
in size, i.e. it contains 300 measurements per channel. When the
variable Start&Stop Cond. is greater than 0.5, this buffer is writ
ten to a file. (If the time for the pre-trigger is greater than the
Size of a single file, then several files are written.) Thereafter,
a file is produced with 10Hz in each case over 300 seconds and
then a new file is started. When the variable Start&Stop Cond. is
less than 0.5, the recording continues for a further 60 seconds
and, where necessary, a new file is also started.

At the end of the measurement storage occurs again in an inter-
mediate buffer and when a new start trigger occurs, i.e. when the
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variable Start&Stop Cond. is again greater than 0.5, the record-
ing starts again.

n IMPORTANT

The start condition is only checked again when the post-trigger
has terminated. If the start condition is fulfilled before the pre-
trigger has expired, recording is started immediately.

The data are written to the SD card (Target memory). You must
therefore promptly connect another storage medium, e.g. a USB
data medium. Otherwise, the two oldest files are deleted and
overwritten with new data (one file more is always deleted than
written new in order to maintain a reserve). When you connect
another storage medium, the files so far created on this medium
are moved, i.e. they are deleted from the SD card after being
written on the new storage medium. The blue LED (RUN) on the
Q.brixx station flashes rapidly until the write process on the new
medium has terminated. With larger storage media this process
and also the detection of the storage medium may take longer, so
it is essential to wait until the LED starts to flash rapidly. When
the blue LED flashes slowly again (this may take longer than a
minute), you can remove the (last connected) storage medium.
Remove the data medium only when the flashing has stopped as
otherwise the copied files may be damaged. Storage of the cur-
rent measurements continues in the background during the
transfer.

Event-based recording with pre-trigger and storage on a network
drive

Recording is to occur when the variable Start Cond. is greater
than 0.5 (the variable is a digital input and contains the value 0 or
1). Overall, each event is to be recorded with 10 seconds pre-trig-
ger and 30 seconds subsequent post-trigger (event length).
Recording should take place at 1000Hz.

Using the settings in Fig. 7-14 the pre-trigger buffer is initially
filled. When the variable Start Cond. is greater than 0.5, this buf-
fer is written to a file along with the following 30 seconds.
Recording takes place in each case at 1000Hz for 40 seconds.
Thereafter the pre-trigger buffer is filled again and the event
awaited. Once the specified 50 events have been recorded, the
file is closed and a new one started.
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i Logger configuration =RACN X
Loggerl \arh
| Data source: Logger type: Logger name: Logger status:
Fast SampleRate - Event-based ~ | |Datalogger_1 ¥ activated
Available variables -
= Fast SampleR ate [with Timestarp)
R Start_Cond.
20 R Focelet Logging rate 10000 Hz
W Force left_Max
R TensileFarce left
= [0 R Foceright
W Force right_tas
R TensileForce right Event Il::l:lnl:litil:ln
Start_Cond. = 0,5
1
I
1
I
1
10 sec
Event length 30 sec
Size of a single file 50 Events —_—
Storage type unprotected maove e
- data is stored directly to the selected device
- after connecting a transport device, all files are moved to the
new device
- move process is indicated by fast flashing blue LED
- remaving the fransport device is save after LED stopped flashing
destinations ___-__-.:sf MNetwork-drive 1 <DataFiles:> hd
-
-
) Expert settings \‘6’/’ oK | 7< Cancel

Fig. 7-14 Event-based measurement.

The data are written to the network drive which you have speci-
fied in the basic settings using Host interface > Network
drive. In this respect refer to Chapter 6, Basic configuration of
your system, page 37, and Section 6.1.3.4, page 46.

Angular synchronous measurement

Carry out the basic setting for this measurement using the con-
text menu Settings of the Test Controller (Fig. 7-15).
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foe. Qustation 101 DT 192.168.100.1 (@192.168.10045) Undef

-8

m--E--8

Mame

@ Settings

@ Slave interface
5 Host interface
(5 USE devices
@ Sample rate

& Count

[ Sample rate #1
= @ Sample rate §2

[¥ Mame

[¥ Synchionization source

[ Digital In

[¥ Edge

[¥ Debouncing count (@46MHz

[& min. time between two Syncs [ps]
[¥ Timestamp type

[ Timestamp reset mode

value

fingle
external
Digital in 2
rizing

1

3000
Cyclecounter

at ref-zsignal - rizsing edge

[¥ Timestamp rezet terminal Digital in 3
[& Buffer size [Butes]: 21600000
\‘5’/’. oK ‘ ?{ Cancel ‘

Fig. 7-15 Example of an angular synchronous measurement.

The signal from the rotary sensor (360 pulses/revolution) is fed
into DI2. The sensor has a zero index signal (pulse-shaped) which
is fed into DI3. The maximum rotational speed is below
20,000rpm, i.e. at least three milliseconds must pass before the
next pulse can come.

The settings for the logger take place as in the other examples.
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Access to data in the
Q.brixx station

You have several ways of reading out data from the Q.brixx sta-
tion or of operating the Q.brixx station remotely.

1. From your PC you can access the Q.brixx station drives, e.g.
the internal memory hd0, through a network and SMB/CIFS.

2. You can remotely control the Q.brixx station through VNC,
e.g. using a VNC viewer.

3. You can transfer the data from the Q.brixx station to an FTP
server; refer to FTP client in Section 6.1.3.3, page 44.

Access through SMB/CIFS

Enter the IP address of the Q.brixx station on your PC in the
search box (Fig. 8-1) and press Return.

L
' See more results

[ \4192.168.100.13 «| | shutdown | » |

Fig. 8-1  Entering the IP address.

The Q.brixx station then appears with the IP address in the list of
network drives or PCs (Fig. 8-2 on page 98).
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Search 19

D)o/ » Network» 19216810043+ [ 4y |

File Edit View Tools Help

Organize * Search active directory

» 3L Favorites

Data
- Share
4 Ml Desktop
I s Libraries
A MPC3
> 1M Computer
4 ?ﬂ Network

» 18 192.168.100.13
» 18 SERVERPC
. /8| TIDPCLO
1% TIDPC12
> @ Control Panel
7 Recycle Bin

g L 1 item

=

.

Fig. 8-2  Q.brixx station as network drive.

You must enter the user name and password to be able to access
the data. To do this, open the entry (the Data directory is shown)

and double click on this directory (Fig. 8-3).

s[5 e S
= e = L A07 4En 1 0
(I [ » Network » 19216810013 » ~ | 44 || search 19216210013 Lo
File Edit View Tools Help
Organize « Search active directory Metwork and Sharing Center » gi - [ i@

» 3 Favorites Data

- Share
4 Bl Desktop
I* 3 Libraries
B MPC3
i 1M Computer
4 qﬂ Neh-;:.ork
478 19216810013
i ¢ Data
- M SERVERPC
- 18 TIDPC10
- /M TIDPC12

Fig. 8-3  Data directory on the Q.brixx station.

In the following dialog enter the user name (data) and password
(ginsdata). Use data as password for older controllers with firm-

ware 1.xx BOx.
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= Note that Windows assumes that you want to log onto the current
domain (if you are a member of a domain). In this case you must
specify \data to bypass the prefixed domain (Fig. 8-4).

Windows Security @

Enter Network Password
Enter your password to connect to: 19216810013

ata |

'DJ — |

[] Remember my credentials

'@' The specified network password is not correct.

oK l ’ Cancel

Fig. 8-4 Login dialog.

Then you are shown the internal memory as hd0 (Fig. 8-5).

| =]

@le.. « 19216810013 » Data » + [ 42 ][ Search Dota o]
File Edit View Tecols Help
Organize New folder =~ 0 @

7 Libraries “ Name Date modified Type
A MPC3
M Computer
e‘ﬂ Network
18 192.168.100.13
4 Data
> Ml SERVERPC
-8 TIDPC10
/M TIpPCI2
> @ Control Panel

. hdd 1211.2009 07:11 File folder
| tmp 27.10.2014 15:35 File folder

eem

- 4| 1 | 3

2 items Offline status: Online
Offline availability: Mot available

Fig. 8-5 Internal memory of the Q.brixx station as network drive.

You can now access the drive just like any other network drive
and copy or move files, etc.

Alternatively you can also select the menu Extras -> Connect
network drive in any Explorer window (Fig. 8-6).
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&) @5 Map Network Drive

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Dirivve: O -

Folder: 44192,168,100, 1 data -

Example: Viserverishare

Reconnect at logon

[C] Connect using different credertials

Connectto a Web site thatywou can use to store wour docurments and pictures,

.

Fig. 8-6  Linking the Q.brixx station as Drive Q.

Then, you obtain, as in the first case, the login dialog (Fig. 8-4), in
which you have to enter the user name data) and password
(ginsdata). Use data as password for older controllers with firm-
ware 1.xx BOx. Then the internal memory is shown as hdO on the
drives of your PC.

= [ Bl [ |
@n\:jka‘ v Computer » data (8192,168,100,13) () » - | ¢,| | Search data (\\I92 168, 100.13) (C) ol

File  Edit View Tools Help

Organize « Mew folder i= « 0 .@.
, % Favorites it Marme : Date modified Type Size

=t

. hdl 12112009 0711 File falder

4 Bl Desktop J trmp 21.10.2014 15:35 File falder

* | Libraries

> A Micha PC2 =

4 M Computer
» =3 Floppy Disk Drive (&)
> &L, Lacal Disk (C)
> i OO Drive (D)
> G data (4192,168,100,13) (Q:)

A?j Metweark

> jM| SERVERPC
> /M TIDPC10 o=
= 2 items Offline status: Online

Offline availability: Not available

Fig. 8-7  Drive Q contains the internal memory hd0.

Now you can also directly access (with both methods) the data
directly with test.viewer and test.node. With test.node you can
even check the logger settings.
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Remote control by VNC

The following section explains how you set up a remote control
using TightVNC in order to be able to operate the (external) mon-
itor of a Q.brixx station using the PC. This also works when no
monitor is connected.

Download the program TightVNC (freeware under GNU General
Public License Version 2) to your computer.
http://www.tightvnc.com/download.php.

Note that the various installation programs depend on the oper-
ating system.

Then install the program (refer to Fig. 8-8 for an example).

Open File - Security Warning ﬁ

Do you want to run this file?

Mame:  LPCIDownloadstightene 27,10 setup-32bit msi
Publisher: GlavSoft LLC.

Type: Windows Installer Package
Fram: ChUsers\MichaPC 3 Download sitightync-2.7.10-5..,

Run ‘ [ Cancel

Always azk before opening this file

potentially harm vour computer. Only run software from publishers

| .ﬁl ‘while fileg from the Internet can be ugeful, this file type can
A4 you brust, What's the risk?

Fig. 8-8  Installing TightVNC.

You only need the TightVNC Viewer to be able to remotely oper-
ate the Q.brixx station. For this use the installation type Custom
(Fig. 8-9).
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1 TightVNC Setup = -2 |

Choose Setup Type
Choose the setup type that best suits vour needs

Typical

Installs the most commaon program Features. Recommendad For most users.

Allows users ko choose which program Features will be installed and where
they will be installed, Recommended for advanced users,

Complete

all program Features will be installed. Requires the most disk space.

Fig. 8-9  Custom installation.

You then have the possibility of installing the TightVNC Viewer
(Fig. 8-10).

3] TightVNC Setup = et

Custom Setup
Select the way you want Features to be installzd,

Click the icons in the tree below ko change the way Features will be installed,

B TightVNC Tight¥MC inchudes bwo components,
¥~ | TightwnC Server Server and Wiewer, Both are
- =30 | Tight¥hC Viewer installed by default,

This Feature requires 23KE on wour
hard drive. It has 1 of 2
subfeatures selected, The
subfeatures require S69KE on your

hard drive.
Laocation: C\Program Files) TightyMC),
[ Reset ][ Disk Usage ] [ Back ][ et ][ Cancel ]

Fig. 8-10 Installing the viewer.

Follow the further instructions of the installation program.

After installation start the program and enter the IP address of
the Q.brixx station (Fig. 8-11).
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Mew TightVNC Connection lil_léj

Connection

Remate Host: 192,165,100,15 - Conneck
Enter a name or an IP address. To specify a port number, -

append it after bwio colons (for exarmple, mypc::5902),
Reverse Connections

Listening mode aI_IUws pe_ople to att.ach YOUr Wiewer to ([ g
their desktops, Viewer will wait for incoming connections,

TightYMC Yiewer

Tight¥MC is cross-platform remote control software,

ﬁ Its saurce code is available to everyone, either Freshy
VNC {GMU GPL license)d or commercially {with no GPL restrictions),

['\-'ersioninfo...] [ Licensing ] ’ Configure. .. ]

Fig. 8-11 Logging onto the Q.brixx station.

In the next dialog enter the password master (Fig. 8-12).

Vnc Authentication [é]
Connected to: - 192,168.100,1&
Password: sssees
[ oK l ’ Cancel ]

Fig. 8-12 Entering the password.

Then the screen is shown in a window and you can operate the
Q.brixx station by clicking on the fields (Fig. 8-13).
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IfbVNCserver - TightVMC Viewer

BHER I 9 @ an | a @l

Controller ‘D“ml

Darmstadt

n 101 0T

system overview

no application @
no information (a1°] WL,MI'JW

System Performance
2 Application Realtime &

©76%| > 98 %

ilalk 0 5% |/os 98 %

Network

+ pHor: W
192.168.100.13

Fig. 8-13 Screen of the Q.brixx station in TightVNC

Of course, you can also use other VNC viewers. Enter the login

data used above at the appropriate points.
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Austria

Germany

International Sales and
Service

The current addresses of our sales partners can be found in the
Internet on our web site. You can take up direct contact with
Gantner Instruments GmbH at any time.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all
sections are open to the public).

Gantner Instruments GmbH
Montafonerstr. 4
6780 Schruns/Austria

Tel.: +43 (0) 5556 77463-0
Fax: +43 (0) 5556 77463-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Gantner Instruments Test & Measurement GmbH
Heidelberger Landstr. 74
64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
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